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Preface

This chapter describes the purpose and organization of this guide. The Preface 
contains the following information:

■ Purpose of this Guide

■ Audience

■ How this Guide is Organized

■ Documentation Set

■ Related Publications

■ Conventions Used in this Guide
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Purpose of this Guide
This guide explains how to configure Oracle® Enterprise Manager Release 2.1. 

Oracle Enterprise Manager is a system management tool which provides an 
integrated solution for managing your heterogeneous environment. The product 
combines a graphical console, agents, common services, and tools to provide an 
integrated, comprehensive systems management platform for managing Oracle 
products.

For program updates and important notes on using Oracle Enterprise Manager, see 
the Oracle Enterprise Manager Readme.

After you have completed the configuration procedures, see the Oracle Enterprise 
Manager online help or the Oracle Enterprise Manager Administrator’s Guide for 
information on how to use Oracle Enterprise Manager.

Audience
This guide is written for DBAs and system administrators who wish to configure 
Oracle Enterprise Manager. You should already be familiar with Oracle and the 
administrative tasks you wish to perform.

For general information about the Oracle8i Release 2 (8.1.6) and how it works, see 
the Oracle8i Release 2 (8.1.6) Concepts Guide. For information about database 
administration procedures, see the Oracle8i Release 2 (8.1.6) documentation set. The 
Oracle8i Release 2 (8.1.6) documentation set contains specific and thorough 
descriptions of the database administration tasks you can perform with Oracle 
Enterprise Manager tools. In addition, the Oracle8i Release 2 (8.1.6) documentation 
set provides recommendations on how to administer your database optimally.

You should also be familiar with the operation of your specific Microsoft Windows 
or Solaris system. See the documentation for your Windows or Solaris system, if 
necessary.
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How this Guide is Organized
This guide is comprised of the following chapters:

Chapter Description

Chapter 1, "Introducing Oracle Enterprise 
Manager"

This chapter provides an overview for configuring Oracle 
Enterprise Manager.

Chapter 2, "Creating a Release 2.1 Repository" This chapter describes how to create a new repository using 
the Oracle Enterprise Manager Configuration Assistant. 

Chapter 3, "Controlling the Management 
Server"

This chapter describes how to start, stop, and check the status 
of the Oracle Management Server.

Chapter 4, "Adding Additional Management 
Servers"

This chapter describes how to add an additional Management 
Server to manage an already existing repository.

Chapter 5, "Starting the Intelligent Agent" This chapter describes how to start the Oracle Intelligent 
Agent.

Chapter 6, "Setting Up the Console" This chapter describes how to configure and start Oracle 
Enterprise Manager Release 2.1.

Chapter 7, "Migrating a Release 1.x Repository 
to a Release 2.1 Repository"

This chapter describes methods for migrating the user’s 
private Release 1.x repositories into a specific user in a new 
Release 2.1 repository.

For information about upgrading a Release 2.0 repository to a 
Release 2.1 repository, see "Upgrade a Release 2.0 Repository 
to a Release 2.1 Repository" on page B-2.

Chapter 8, "Setting Up DBA Studio" This chapter describes how to set up DBA Studio.

Appendix A, "Directory Structure" This appendix describes the directory structure of Oracle 
Enterprise Manager Release 2.1.

Appendix B, "Configuration Assistant 
Operations"

This appendix describes how to upgrade a repository, how to 
drop a repository, and how to redirect the local Management 
Server to use a different repository or to respond to changes 
in the repository user’s password.

Appendix C, "Troubleshooting" This appendix describes possible issues for troubleshooting.

Appendix D, "Repository Sizing" This appendix contains recommendations for repository 
sizing.

Appendix E, "Configuring the Webserver and 
Directory Mapping"

This appendix contains information about configuring your 
webserver and directory mapping if you did not install the 
Oracle Application Server Listener.
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Documentation Set
The Oracle Enterprise Manager Release 2.1 documentation includes the following:

■ The Oracle Enterprise Manager Readme Release 2.1 provides important notes on 
updates to the software and other late-breaking news, as well as any differences 
between the product’s behavior and how it is documented.

■ The Oracle Enterprise Manager Configuration Guide Release 2.1 provides 
information about configuring the Oracle Enterprise Manager system.

■ The Oracle Enterprise Manager Concepts Guide Release 2.1 provides an overview 
of the Enterprise Manager system.

■ The Oracle Enterprise Manager Administrator’s Guide Release 2.1 describes the 
components and features of the Oracle Enterprise Manager system.

■ The Oracle Intelligent Agent Users Guide describes how to administer the Oracle 
Intelligent Agent.

■ The Oracle Enterprise Manager Messages Manual Release 2.1 contains probable 
causes and recommended actions for Oracle Enterprise Manager errors.

In addition to the Oracle Enterprise Manager documentation set, extensive on-line 
help is provided for components in Oracle Enterprise Manager.
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Related Publications
The Oracle Enterprise Manager Configuration Guide refers to important information in 
the related publications. The related books referred to in this guide are listed below:

■ For general information about the Oracle8i Release 2 (8.1.6) and how it works, 
see Getting to Know Oracle8i Release 2 (8.1.6) and Oracle8i Release 2 (8.1.6) 
Concepts.

■ For information about administering the Oracle8i Release 2 (8.1.6), see the 
Oracle8i Release 2 (8.1.6) Administrator’s Guide.

■ For the procedures for migrating a previous version of Oracle, see Oracle8i 
Release 2 (8.1.6) Migration.

■ For information on Oracle’s SQL commands and functions, see the Oracle8i 
Release 2 (8.1.6) SQL Reference.

■ For information about utilities bundled with the Oracle8i Release 2 (8.1.6), refer 
to the Oracle8i Release 2 (8.1.6) SQL Reference.

■ For information about Oracle messages and codes, refer to Oracle8i Release 2 
(8.1.6) Error Messages.

■ For information about the Oracle networking system, see your network-specific 
documentation.

■ For information about the Oracle8i Release 2 (8.1.6) on Windows NT, see the 
Oracle8i Release 2 (8.1.6) Installation Guide for Windows NT, the Oracle8i Release 2 
(8.1.6) Administrator’s Guide for Windows NT, and the Release Notes.

■ For information on Oracle Parallel Server, refer to the Oracle8i Release 2 (8.1.6) 
Parallel Server Setup and Configuration Guide, which provides essential 
information for preparing Oracle8i Release 2 (8.1.6) for use with Oracle Parallel 
Server and Oracle Enterprise Manager. The "Introducing Oracle Parallel Server" 
chapter provides a conceptual and component overview of Oracle Parallel 
Server. This information will help you prepare and plan your Oracle Parallel 
Server installation and configuration in an Oracle8i Release 2 (8.1.6) 
environment. 
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Conventions Used in this Guide
The following sections explain the conventions used in this guide.

Examples
This guide contains code examples. Note that the text of examples appears in a 
different font than the text of the guide. This is an example of a SELECT statement: 

SELECT * FROM emp

Examples in this guide follow these case conventions: 

■ Keywords, such as CREATE and NUMBER, appear in uppercase. Keywords 
have special meanings. When you specify them, they can be in uppercase or 
lowercase, but they must be used exactly as they appear in the code example.

■ Names of database objects and their parts, such as emp and empno, appear in 
lowercase. However, in the text of this guide, names of database objects and 
their parts appear in uppercase.

■ Parameters act as place holders in examples. They appear in lowercase. 
Parameters are usually names of schema objects, Oracle datatypes, or 
expressions. When you see a parameter in a syntax diagram, you should 
substitute an object or expression of the appropriate type. Note that parameter 
names appear in italics in the text of this guide.

Command Syntax
■ Italics is used for variables, such as application_name. Substitute an 

appropriate value. 

■ | denotes alternative choices

■ {param1 | param2 | ... } signifies that one of the parameters in {} must be used. 
Do not type the brackets.

■ [  ] identifies optional parameters. Do not type the brackets.
xiv                                                                                    



                                                            Introducing Oracle Enterprise Ma
1

Introducing Oracle Enterprise Manager

Oracle Enterprise Manager is a system management tool which provides an 
integrated solution for centrally managing your heterogeneous environment. Oracle 
Enterprise Manager combines a graphical Console, Oracle Management Servers, 
Oracle Intelligent Agents, common services, and tools to provide an integrated, 
comprehensive systems management platform for managing Oracle products.

This introduction discusses the topics listed below:

■ Oracle Enterprise Manager’s Architecture

■ Oracle Enterprise Manager System and Hardware Requirements

■ Basic Terminology

■ Configuring Oracle Enterprise Manager Overview
nager 1-1



Oracle Enterprise Manager’s Architecture
Oracle Enterprise Manager’s Architecture
Oracle Enterprise Manager has a three-tiered architecture. The first tier, the client, 
consists of a Java-based Console and integrated applications. The second tier is the 
Management Server or designated group of Management Servers which provides 
centralized intelligence and distributed control between clients and targets. The 
third tier is comprised of targets, such as databases, nodes, or other managed 
services. An Intelligent Agent resides on each target and monitors the services in 
the target for registered events (potential problem occurrences) and executes jobs 
sent by the Console via the Oracle Management Server(s).

Only one agent can exist per machine, regardless of the number of services on that 
machine.
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Oracle Enterprise Manager’s Architecture
Oracle Enterprise Manager’s three main components are listed below: 

For further details regarding the architecture of Oracle Enterprise Manager Release 
2.1, refer to chapter 1 of the Oracle Enterprise Manager Concepts Guide.

Component Function

Console The Console gives you a central point of control for the Oracle 
environment through an intuitive graphical user interface (GUI) that 
provides powerful and robust system management. 

Management Server The Oracle Management Server provides centralized intelligence and 
distributed control between the Console and the managed nodes. It 
processes system management tasks sent by the Console and 
administers the distribution of these tasks across the enterprise. The 
Oracle Management Server stores all system data, application data, 
and information about the state of managed nodes in a repository, 
which is a set of tables stored in a database. The Management Server 
in charge of a job or event stores all the information about the status 
of the job or event (whether it is scheduled, waiting for a response 
from the Intelligent Agent, waiting to notify the Console, and so on.) 
High performance and scalability is ensured because the workload is 
automatically shared and balanced when there are multiple 
Management Servers.

Intelligent Agent The Intelligent Agent is a process that runs on managed nodes in the 
network. It functions as the executor of jobs and events sent by the 
Console via the Management Servers. 
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Oracle Enterprise Manager System and Hardware Requirements
Oracle Enterprise Manager System and Hardware Requirements
You can run Oracle Enterprise Manager components in any configuration 
depending on your management environment. For example, you can run each tier 
on separate machines or run all three tiers on one machine.

Running Enterprise Manager components on separate machines requires the 
following:

Machine running only the Console and DBA Management Pack:

■ Pentium I 266 MHz or SPARC 20

■ 64 MB RAM

■ 190 MB available hard disk space

Note: Running the Enterprise Manager Console from a web browser requires 64 MB 
RAM. Running the web site and Oracle Application Server Listener requires 102 
MB.

Note: The integrated applications require an additional 18 MB.

Machine running only the Management Server:

■ Pentium II 300 MHz or SPARC Ultra 1

■ 64 MB RAM

■ 190 MB available hard disk space (If you turn Tracing on, you should allocate 
an additional 50 MB for Trace logs.)

Running the entire Enterprise Manager bundle (Console, DBA Management Pack, 
Oracle Management Server and database repository) from a single machine requires 
the following:

■ Pentium II 400 MHz or SPARC Ultra 1

■ 128 MB RAM

■ 190 MB available hard disk space (Includes 6-26 MB for configuring the 
Repository. Refer to Appendix D, "Repository Sizing" for information on how 
much you can expect your repository to grow. In addition, if you turn Tracing 
on, you should allocate an additional 50 MB for Trace logs.)

Note: The requirements outlined above assume that a database for the Enterprise 
Manager Repository already exists. If a database has not already been installed, you 
must install one. For recommended system and hardware requirements for an 
Oracle database, refer to the installation guide provided with that database release.
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Oracle Enterprise Manager System and Hardware Requirements
The default Enterprise Manager package (using a single Oracle Management Server 
in your environment) is tuned to best support an environment with the following 
characteristics:

■ 40-50 different machines 

■ A total of 80-100 managed database instances or other managed targets (up to 
10 managed targets on any one node) 

■ Up to 12-15 Consoles actively being used at one time or unlimited Consoles 
being used for intermittent/passive work

■ 10 jobs running per node per day

■ 10 events triggering per node per day

To improve performance when the number of managed nodes increases, Oracle 
recommends either (1) adding one Management Server per 50 nodes managed or (2) 
increasing CPU capacity on the Management Server machine/s.

To improve performance when the number of Consoles, jobs or events increases, 
Oracle recommends increasing resource capacity on the Repository database 
machine.
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Basic Terminology
Basic Terminology
Refer to the Oracle Enterprise Manager Concepts Guide and the Oracle Enterprise 
Manager Administrator’s Guide for detailed information about the terms listed below.

What is a repository?
A repository is a set of tables in a database containing state information for the 
managed environment and information about the management packs. It is used as a 
back-end store by the Oracle Management Servers, providing distributed control 
between clients and managed nodes.

What is a repository owner?
An Enterprise Manager repository is owned by a database user. During repository 
creation a repository’s user name is entered that will be used to create this database 
user. If the repository user name and encrypted password are saved during 
repository creation, the Management Server uses them to login to the repository; if 
they are not saved, the Management Server prompts the user for a user name and 
password before it starts up.

What is an administrative user?
Oracle Enterprise Manager is installed with a default super administrator account 
which can be used for the initial login. The super administrator account is sysman 
and the initial password is oem_temp. The password must be changed after the 
initial login. Using this account you can create other super administrators, as 
needed. Administrative data stored in the repository is filtered based on 
administrator permissions. Preferences, such as preferred credentials, login 
password, and notification schedules, must be set for each administrator.

The Oracle Enterprise Manager Release 2.1 credentials should not be confused with 
the username and password of an individual database user account (which is 
different from an Oracle Enterprise Manager administrator account or the 
repository credentials).
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What is a Console?
The Console, a graphical interface for administrators, is a Java-based application 
that can be run as either a "thin" or "fat" client. Thin clients use a web browser to 
connect to a server where Console files are installed, whereas fat clients require 
Console files to be installed locally. 

However you run the Console, it relies on the Oracle Management Server and the 
Oracle Intelligent Agent to perform system management tasks. 

What is an Oracle Management Server?
Management Servers provide centralized intelligence and distributed control 
between clients and managed nodes, and process system management tasks.

As the number of nodes and managed services in your network increases or if the 
current Management Server is overloaded, you can add more Oracle Management 
Servers to the middle tier to share and balance the workload. These additional 
Management Servers provide fault-tolerance in the case where one Management 
Server becomes unavailable.

All Management Servers administering the same set of managed nodes share a 
single Repository, which stores all system data, application data, and the state of 
managed nodes throughout the environment. 

What is the Oracle Intelligent Agent?
An Oracle Intelligent Agent is installed on each node to run jobs and monitor events 
sent by the Management Server. Intelligent Agents function independently of the 
database or services they support, as well as being independent of the Management 
Server and Console clients. 

What is service discovery?
When you use the Discovery Wizard in the Console, the Management Server 
contacts the Intelligent Agent installed on that node to discover the Oracle services 
installed on the node.

The Management Server then places the new information in the repository, and 
updates the Console Navigator, displaying a view of all nodes and their respective 
services.

Service discovery allows administrators to run jobs and monitor for events on those 
nodes and allows the information to be centrally managed by the Consoles.
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What are preferred credentials?
This section contains information about:

■ preferred credential saved through the Oracle Enterprise Manager Console

■ local preferred credentials saved through DBA Studio

Preferred Credentials Saved Through the Oracle Enterprise Manager Console
Each administrator can set up specific usernames, passwords, and roles (NORMAL, 
SYSOPER, or SYSDBA) for nodes, listeners, databases, and other services that you 
administer in the network.

After you set up preferred credentials, you are no longer prompted for credentials 
when connecting to the managed targets. 

The Preferred credentials you set up through the Console also allow you to use the 
job and event system for targets where credentials are required. All login credentials 
set up through the Console are encrypted in the repository. 

Local Preferred Credentials Saved Through DBA Studio
DBA Studio stores a list of databases that are displayed in the DBA Studio navigator 
tree. If preferred credentials are specified for any of these databases, the username, 
encrypted password, and role are added to a local file.

Saving or editing preferred credentials is an option which enables you to store login 
information, such as username, password, and role (NORMAL, SYSOPER, or 
SYSDBA). Passwords are always stored in encrypted format. This login information 
is used when a connection is established for the database instead of having to type a 
username and password each time.
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Configuring Oracle Enterprise Manager Overview
In order to configure Oracle Enterprise Manager, you need to perform the following 
steps. 

Some of the steps are optional depending on which features you intend to use.

Procedure Required or Optional See

Install an Oracle database and install 
Oracle Enterprise Manager.

Required Refer to the 
installation guide 
provided with the 
database release.

Run the Enterprise Manager 
Configuration Assistant to create a 
repository if you do not have one. 
During the Oracle Enterprise 
Manager installation, you will be 
asked if you want to use an existing 
repository or create a new one. 

If you need to upgrade your 
repository from Release 2.0 to 
Release 2.1, see "Upgrade a Release 
2.0 Repository to a Release 2.1 
Repository" on page B-2.

Required "Creating a 
Release 2.1 
Repository" on 
page 2-1.

Run the Migration Assistant to 
migrate data you are using in your 
V1.x environment from one or 
multiple private repositories into a 
specific user in your new Release 2.1 
repository

Optional

If you do not have a Version 1 repository, skip this 
step.

"Migrating a 
Release 1.x 
Repository to a 
Release 2.1 
Repository" on 
page 7-1.

Add additional Management Servers Optional

If you do not need to add additional Management 
Servers, skip this step. Many environments will 
require just one Management Server.

"Adding 
Additional 
Management 
Servers" on page 
4-1.

Start Intelligent Agent Required "Starting the 
Intelligent Agent" 
on page 5-1.

Start Management Servers Required

Starting and configuring at least one Management 
Server is required.

"Controlling the 
Management 
Server" on page 
3-1.
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Start Console Required "Starting the 
Enterprise 
Manager 
Console" on page 
6-2.

Discover services Required

You must identify the network services so that 
these services, such as databases and listeners, can 
be administered with Enterprise Manager 
components. 

"Discovering 
Services" on page 
6-4.

Create administrator accounts Required

Creating accounts gives administrators the ability 
to customize their own Console views and share 
and secure management data between 
administrators

"Creating 
Administrator 
Accounts" on 
page 6-5.

Install the web browser, install the 
Oracle Enterprise Manager web site, 
and install and configure a 
webserver (if you have not installed 
the Oracle Application Server 
Listener) to run Oracle Enterprise 
Manager from a web browser.

Optional

If you do not want to run Oracle Enterprise 
Manager from a web browser, skip this section.

"Running Oracle 
Enterprise 
Manager from a 
Web Browser" on 
page 6-6.

Create Windows NT user account 
with privileges to submit jobs

Required

In order for the Intelligent Agent to execute jobs on 
a managed node, an appropriate NT user account 
must exist.

"Creating a 
Windows NT 
User Account for 
Running Jobs" on 
page 6-12.

Set up Preferred Credentials on 
nodes

Required

In order for the Intelligent Agent to execute jobs on 
a managed node, the preferred credentials for the 
node must be set for each administrator.

"Setting Up 
Preferred 
Credentials for 
Managed 
Services" on page 
6-16.

Set up email notification Optional

Setting up email notifications enables you to 
receive notifications for jobs or events via email.

 "Setting Up 
Email 
Notification" on 
page 6-17.

Set up paging service Optional

One paging service installation per network is 
required if you want to receive notifications for jobs 
or events via pagers.

"Configuring and 
Starting the 
Paging Service" 
on page 6-20.

Procedure Required or Optional See
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Configure a remote database for 
backup or SYSDBA administration

Required if not already set

Before using one of the backup management 
wizards or starting up or shutting down a database 
through Oracle Enterprise Manager, your database 
must be set up for remote sysdba management. 

You may need to configure both the server and 
client if they have not been configured already 
through the Database Configuration Assistant. 

"Configuring a 
Remote Database 
for Backup or 
SYSDBA 
Administration" 
on page 6-38.

Set up DBA Studio. Optional

Configure DBA Studio if you want to access 
database administration features and manage 
multiple databases from one tool

"Setting Up DBA 
Studio" on page 
8-1.

Procedure Required or Optional See
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Creating a Release 2.1 Repository

In Oracle Enterprise Manager Release 2.1, a repository contains state information 
for the managed environment and information about the management packs. The 
repository is used as a back-end store by the Oracle Management Servers, providing 
distributed control between clients and managed nodes.

In Release 2.0, the Enterprise Manager Configuration Assistant only created the 
repository for the base Oracle Enterprise Manager product. In Release 2.1, it now 
creates the repository for all Oracle Enterprise Manager products. The Oracle 
Enterprise Manager repository is treated by the Enterprise Manager Configuration 
Assistant as a single entity. Regardless of whether you have additional products 
installed, creating a repository will create all parts of a repository. 

The Enterprise Manager Configuration Assistant provides the database 
administrator with repository creation, removal, upgrade, and configuration 
parameter maintenance. 

If you are a new Oracle Enterprise Manager user, or if you want to create a new 
Release 2.1 repository, you will use the Create a New Repository option of the 
Enterprise Manager Configuration Assistant to create and load your Release 2.1 
repository and set up the configuration parameters for a local Management Server.

If you are using a Release 2.0 repository and want to upgrade your repository from 
Release 2.0 to Release 2.1, refer to "Upgrade a Release 2.0 Repository to a Release 2.1 
Repository" on page B-2.

If you are using a previous Enterprise Manager Release 1.x and want to migrate 
your 1.x repository or repositories directly to a Release 2.1 repository, you will need 
to perform additional steps using the Enterprise Manager Migration Assistant after 
creating your Release 2.1 repository. Refer to Chapter 7, "Migrating a Release 1.x 
Repository to a Release 2.1 Repository" for information about migrating one or 
more Release 1.x repositories into the shared Release 2.1 repository schema.
sitory 2-1



Refer to "Setting Up an Additional Management Server" on page 4-2 for information 
on setting up or adding a Management Server to manage an already existing 
repository. 

In a multiple Management Server environment, you must run the Enterprise 
Manager Configuration Assistant on every machine that will be running a 
Management Server. The repository can exist on a different machine from the 
Management Server.

Important: The Enterprise Manager Console, DBA Management Pack, 
separately licensable Packs, Management Server and repository must all 
be of the same release. For example, you cannot use a Release 2.0 
Management Server and repository with a Release 2.1 Console nor can 
you use a Release 2.1 Management Server and repository with a Release 
2.0 Pack.   Any Enterprise Manager Release 2.1 product must use a 
Release 2.1 Management Server and repository, where product refers to 
any of the following:

■  Oracle Enterprise Manager Console

■  Oracle DBA Management Pack

■  Oracle Tuning Pack

■  Oracle Diagnostics Pack

■  Oracle Change Management Pack

■  Oracle Management Pack for Oracle Applications

■  Oracle Management Pack for SAP R/3

■  Oracle Standard Management Pack

If the existing Management Server and repository are of a previous 
version, then you can migrate or upgrade them to the most recent 
version. In the case of migrating or upgrading a Management Server and 
repository to Release 2.1, ensure that all Enterprise Manager products 
you intend to use with the repository are of Release 2.1. For instance, do 
not upgrade the Management Server and repository to Release 2.1 if you 
are still using Diagnostics Pack Release 2.0 or Change Management Pack 
Release 2.0. If you upgrade your Management Server and repository to 
Release 2.1 before obtaining the Release 2.1 Pack software you intend to 
use, you will not be able to use the older Pack product(s).
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Creating a New Release 2.1 Repository
The Oracle Enterprise Manager Release 2.1 repository is not the same as a Release 
1.x repository. In Enterprise Manager Release 1.x, each administrator has his own 
repository schema, which contains a current view of the network and user-specific 
information. In Enterprise Manager Release 2.1, administrators have individual 
accounts and preferences within a single "shared" repository schema.

When creating a new Release 2.1 repository, the Enterprise Manager Configuration 
Assistant performs the following tasks for you:

■ creates a new database user who will own the Enterprise Manager and 
management packs repository

■ assigns proper privileges and roles to the new database user

■ creates a new tablespace for the Enterprise Manager and management packs 
repository or uses an existing tablespace if necessary

■ loads information into the repository; this information is required when 
running Oracle Enterprise Manager. 

■ creates and/or updates the local Management Server’s configuration file: 
ORACLE_HOME\sysman\config\omsconfig.properties 

■ loads information into the Oracle Enterprise Manager client, thereby allowing 
the Oracle Enterprise Manager Console to include the Management Server node 
in the list of accessible Management Server nodes

■ starts your Management Server service if you had launched the Enterprise 
Manager Configuration Assistant from an installation session and have chosen 
to save your repository username and password during repository creation 
(Windows NT only)
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Starting the Enterprise Manager Configuration Assistant

To start the Enterprise Manager Configuration Assistant, perform the following 
steps:

■ On Windows NT:

You can start the Enterprise Manager Configuration Assistant from the 
Windows Start Menu->Programs->Oracle-<Oracle_Home_Name>-> Enterprise 
Manager->Configuration Assistant.

■ On UNIX:

You can start the Enterprise Manager Configuration Assistant from the 
command line using the command:

emca

Note: A database must be installed and running before you can create 
the Oracle Enterprise Manager repository schema.

Note: You must be logged in as the owner of the 
omsconfig.properties file (have permission on the file) to execute 
this command.
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Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant as a standalone 
application, the “Configuration Operation” page appears. 

When the Configuration Assistant is launched from an installation session and you 
have selected to create a new repository from the install dialog, the Configuration 
Operation screen will not appear. The screen will be "Select Database for 
Repository." In this case, proceed to Step 2 of 5 on page 2-6.

Select “Create a new repository” from the list of repository operations and press 
Next. The "Select Database for Repository" page appears.
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Step 2 "Select Database for Repository"
Log in to the database where you want to create the repository. 

User name and Password: You must connect to the database as a user with DBA 
privileges. This is an individual database user account, not an Oracle Enterprise 
Manager administrator account.

For example, system/manager.

Service: The service may be specified using the form:

<host>:<port>:<sid> 

where

host is the machine name where the database is located

port is the database listener port address, usually 1521 or 1526
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SID is the database system identifier

An example: 

pjlee-pc:1521:orcl

which connects to the orcl database using port 1521 on the pjlee-pc machine. 

Press Next to continue. 

Refer to "Troubleshooting the Enterprise Manager Configuration Assistant" on page 
C-18 for information about error messages.

When configuring your repository, choose a database that meets the following 
criteria: 

■ the database is always available. 

■ the database will not be shutdown by other administrators. 

■ the database does not compete for resources on the machine where it is 
running. 
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Step 3 "Repository Login Information"
An Enterprise Manager repository is owned by a database user. During repository 
creation, a database user (repository schema user) who owns the repository will be 
created by the Enterprise Manager Configuration Assistant with the username and 
password you enter on this page.

User name: Enter the repository’s user name that will be used to create a database 
user that will own the repository. The repository’s user name must be unique across 
the network. The TCP/IP hostname of the machine is assumed to be unique; 
therefore it is used by default. If you choose another name, you must ensure that it 
is unique. 

Password: Enter the password for that user.

Confirm: Verify the password by typing it again.

You can choose whether to save the user name and encrypted password in the 
omsconfig.properties file, which is read by the Management Server on 
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startup. If these repository credentials are stored in the file, the Management Server 
uses them to login to the repository; if they are not saved, the Management Server 
prompts you for a user name and password before it starts up.

If you do not want to store the user name and encrypted password in the 
omsconfig.properties file, check the "Do not save username and password" 
checkbox.

If the username you chose for your repository already exists, the Select Repository 
User Tablespace page is skipped. The Create Repository Summary page is your next 
page.

Note: The repository schema user created by the Enterprise Manager 
Configuration Assistant is different from the individual database user 
account with DBA privileges that you use to connect to a database in the 
"Select Database for Repository" step of the Enterprise Manager 
Configuration Assistant. The repository schema user will not have the 
necessary DBA privileges for this step. 

To avoid potential security issues, do not grant more privileges to your 
repository schema user than is necessary. 

For the "Select Database for Repository" step of the Enterprise Manager 
Configuration Assistant, connect to the database as a database user with 
DBA privileges instead of granting DBA privileges to the repository 
schema user and using it to connect to the database. For example, 
system/manager.

For the "Repository Login Information" step of the Enterprise Manager 
Configuration Assistant, logon to the repository database as the 
repository schema user. 
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Step 4 "Select Repository User Tablespaces"
The Select Repository User Tablespaces page does not appear:

■ If the repository user already exists, 

or

■ If the Enterprise Manager Configuration Assistant is run from a typical install, 
and: 

■ If the OEM_REPOSITORY tablespace already exists, and: 

■ If the OEM_REPOSITORY tablespace has the appropriate size attributes

Note: Do not install the Oracle Enterprise Manager repository into the 
SYSTEM (especially the SYSTEM tablespace of your production 
database), ROLLBACK, or TEMPORARY tablespaces. The tablespace 
parameter settings used for the SYSTEM tablespace are not appropriate 
for Oracle Enterprise Manager use. You should only use the SYSTEM 
tablespace for "system" entities. Tools, users, and management products 
such as Oracle Enterprise Manager should be placed in other tablespaces. 

ROLLBACK tablespaces are used for creating rollback segments. 
Rollback segments are used by Oracle user processes to store rollback 
information. TEMPORARY tablespaces, which are assigned as 
TEMPORARY tablespaces for users, are used by Oracle user processes as 
a "scratch pad." Both of these tablespaces fluctuate in tablespace usage 
when the database is up and running.

The TEMPORARY tablespace can be used as the user’s temporary 
tablespace.

For more details, refer to the Oracle8i Release 2 Concepts Guide.
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If the OEM_REPOSITORY tablespace already exists, the following screen appears.

 

Select the default and temporary tablespaces for the Enterprise Manager repository 
to use. 
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If the OEM_REPOSITORY tablespace does not exist, the following screen appears: 

Default Tablespace:

■ Create a new OEM_REPOSITORY tablespace (recommended).

Select this option if you want to create the OEM_REPOSITORY tablespace, 
which has specific characteristics for the Enterprise Manager repository, and use 
it as the user’s default tablespace. 

■ Override default datafile name. 

Select the checkbox if you want to change the default name of the datafile for 
the OEM_REPOSITORY tablespace. 

■ Use an existing tablespace

Select an existing tablespace from the pull-down list.
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Temporary Tablespace

Select a temporary tablespace from the pull-down list.

Click Next to continue.

If the Enterprise Manager Configuration Assistant detects that the default 
tablespace for the repository contains the required amount of free space, the “Create 
Repository Summary” page appears.
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Step 5 "Create Repository Summary"
The “Create Repository Summary” page appears, showing a summary of the 
processing to be performed. Verify that all of the information supplied during the 
create repository wizard operation is accurate. 

Click Finish to initiate repository creation or click Back to return to previous pages 
to make modifications.

When you click the Finish button, the Configuration Assistant Progress window 
appears, showing the processing performed and the processing steps that comprise 
the operation being performed. 
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Step 6 "Configuration Assistant Progress Window"
If you want to see detailed information about what is happening during the 
processing, including any errors that might occur, click the "Show Details" button to 
expand the dialog to show a text area. You can hide the detailed information by 
clicking the "Hide Details" button. 

The Cancel button changes to a Close button when processing is completed whether 
it is successful or not.

When all of the steps have been completed without error, the "Processing 
completed." message appears.

You can cancel the requested operation before it completes by clicking the Cancel 
button. 

You must click the Close button to exit the Configuration Assistant.

Note: If you cancel the repository creation while it is in progress, the 
state of the repository is in doubt. In these circumstances, you should 
drop the repository using the Enterprise Manager Configuration 
Assistant.
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Controlling the Management Server

The Management Server provides distributed control between clients and managed 
nodes. A central engine for notification, it processes all system management tasks 
and administers the distribution of these tasks across the enterprise.

Specific topics discussed in this chapter are listed below:

■ Starting the Management Server

■ Checking the status of the Management Server

■ Stopping the Management Server
erver 3-1
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Starting the Management Server

To start the Management Server, perform the following steps.

See "Edit Configuration Parameters" on page B-8 if you need to add or change the 
repository connection information for a Management Server.

For information on troubleshooting the Management Server if it does not start, refer 
to "Checking the Management Server Log Files" on page 3-7.

On Windows NT:
1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>ManagementServer service.

3. Click the Startup push-button to access the Service Startup dialog box.

a. In the Startup Type section, specify how the Management Server service is 
started up by choosing Automatic or Manual. Manual allows the 
Management Server to be started by a user. Automatic allows the 
Management Server to start automatically whenever the user starts the 
system. Disabled does not allow the Management Server to start at all.

b. In the Log On As section, check for the following settings:

* Ensure that the System Account option, which is the supported way to 
run the Management Server, is selected; otherwise, it may no longer 
appear when you log out.

* Ensure that the "Allow Service to Interact with Desktop" box is 
deselected. Do not check "Allow Service to Interact with Desktop" 
unless you are requested by support for troubleshooting purposes. If 
this box is checked, the Management Server will try to create a DOS 

Note: The repository database must be started and open before starting 
the Management Server.

Note: Oracle Enterprise Manager does not support starting a 
Management Server that is not local to your machine (i.e., a remote 
Management Server).
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console on the default desktop. If no one is logged in, the Management 
Server will hang. 

c. If you have chosen not to store your repository credentials during 
repository creation, you must enter the repository’s user name that was 
used to create the database user and the password for that user in the 
Service Startup dialog box when you start the Management Server. 

If you do not supply your repository credentials in the Service dialog, the 
Management Server will not start. If you enter the wrong credentials, the 
Management Server also will not start.

For a complete definition of a repository owner, refer to "Step 3 "Repository 
Login Information"" on page 2-8.

For information on troubleshooting the Management Server if it does not 
start from the Windows NT Start menu, refer to "Management Server Does 
Not Start from the Windows NT Start Menu" on page C-12.

4. Click the Start push-button to start the Management Server. 

On UNIX:
At the command line, enter

% oemctrl start oms

If you want to start the Management Server as a background process, at the 
command prompt, enter 

% oemctrl start oms&

The command string is case-sensitive and must be entered with lowercase 
characters. 

Note: Your Management Server service is started automatically on 
Windows NT during repository creation if you had launched the 
Enterprise Manager Configuration Assistant from an installation session 
and if you have chosen to save your repository credentials.

If you have chosen not to save your repository credentials, you must 
enter them in the Service Startup dialog box. 
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When you are prompted, enter the repository’s user name that was used to create 
the database user and the password for that user if you have chosen not to save 
your repository credentials during repository configuration. For a complete 
definition of a repository owner, refer to "Step 3 "Repository Login Information"" on 
page 2-8.

Note: If the ORACLE_HOME environment variable is not set to the 
Oracle home in which the Management Server is running, the 
Management Server will not start correctly because it will try to find its 
class files in the default Oracle home instead of the correct Oracle home. 
For information on setting the Oracle environment, refer to 
"Management Server May Not Run Correctly from a Non-Default Oracle 
Home" on page C-11.
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Checking the Status of the Management Server
To check the status of the Management Server, at any operating system prompt, 
enter: 

% oemctrl status oms

The command string is case-sensitive on UNIX and must be entered with lowercase 
characters. 

You will be prompted to enter the username and password of an Oracle Enterprise 
super administrator. For a complete definition of an Oracle Enterprise Manager 
super administrator, refer to "What is an administrative user?" on page 1-6. 

You will also need to provide the hostname for the machine running the 
Management Server if you are checking the status of a remote Management Server. 

The following information is provided when you check the status of the 
Management Server:

■ overall status of the Management Server

■ length of time the Management Server has been running

■ statistics regarding the performance of the Management Server 

An example of the output is shown below:

OEMCTRL for Windows NT: Version 2.1.0.0.0
Copyright (c) 1998, 1999 Oracle Corporation.  All rights reserved.

The Oracle Management Server on host [pjlee-pc.us.oracle.com] is functioning 
properly.

  The server has been up for 0 00:03:55.437

  Target database session count: 1 (session sharing is off)
  Operations queued for processing: 0
  Number of OMS systems in domain: 1 (pjlee-pc)
  Number of administrators logged in: 1
  Repository session pool depth: 15
  Repository session count: 6 in-use and 1 available, pool efficiency: 70%
                                                                    Controlling the Management Server 3-5



Stopping the Management Server
Stopping the Management Server

To stop the Management Server, perform the following steps: 

On Windows NT:
1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>ManagementServer service.

3. Click the Stop push-button to stop the Management Server. 

You will be prompted to enter the username and password of an Oracle Enterprise 
super administrator. For a complete definition of an Oracle Enterprise Manager 
super administrator, refer to "What is an administrative user?" on page 1-6. 

On UNIX:
At the command line, enter

% oemctrl stop oms

The command string is case-sensitive and must be entered with lowercase 
characters. 

You will be prompted to enter the username and password of an Oracle Enterprise 
super administrator. For a complete definition of an Oracle Enterprise Manager 
super administrator, refer to "What is an administrative user?" on page 1-6. 

Note: Stopping a Management Server that is not local to your machine 
(i.e., a remote Management Server) is not supported.
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Checking the Management Server Log Files
For information to troubleshooting the Management Server if it does not start, refer 
to the following resources:

■ the oms.log file

■ the oms.nohup file (for Solaris)

■ the Windows NT Event Log (for Windows NT)

The $ORACLE_HOME\sysman\log directory contains the output of traces that are 
redirected to disk. This directory contains the oms.log and oms.nohup files. 

The Management Server places all its trace messages in oms.log file. The oms.log 
file contains messages generated when the Management Server is starting and 
running.

The oms.nohup file contains Management Server error messages which appear 
before the Management Server starts up. 

To access the Windows NT Event Log to view the events logged by the 
Management Server. 

1. From the Start menu->Programs->Administrative Tools (Common), select the 
Event Viewer item.

2. Select Application from the Log menu.

3. When the log screen appears, double-click any event logged by the 
Oracle<Oracle_Home_Name>ManagementServer service which have red 
octagonal stop signs next to them. These will be the errors reported by the 
Management Server, if any. 
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Adding Additional Management Servers

With its three-tiered architecture, Oracle Enterprise Manager is more scalable than 
ever in maintaining performance and automating routine tasks in rapidly growing, 
distributed environments. 

As the number of nodes and managed services in your network increases or if the 
current Management Server is overloaded, you can add more Oracle Management 
Servers to the middle tier to share and balance the workload. In an environment 
with multiple Oracle Management Servers, a set of Management Servers share the 
same repository.

Multiple Oracle Management Servers provide fault tolerance for each other. If an 
Oracle Management Server fails, the other Management Servers continue to 
perform and operate. The clients that registered with the failed Management Server 
can immediately log in again, registering with any of the other Management Servers 
administering the same repository, and work continues with the remaining 
available Oracle Management Servers. Any clients that had been configured to 
register with a different Oracle Management Server than the one that failed are 
unaffected.

To improve performance when the number of managed nodes increases, Oracle 
recommends either (1) adding one Management Server per 50 nodes managed or (2) 
increasing CPU capacity on the Management Server machine/s.

This chapter describes how to set up or add a Management Server to manage an 
already existing repository.

 

Note: If you do not need to set up or add a management server to 
manage an already existing repository, skip this chapter. 
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Installing an Additional Management Server
You must install the additional Oracle Management Server from the Oracle Server 
CD-ROM on any machine where there are no other Management Servers installed. 
Refer to the installation guide provided with the database release for detailed 
instructions.

Setting Up an Additional Management Server
When you add a new management server, you must run the Enterprise Manager 
Configuration Assistant to update the configuration file for that node.

For information about starting the Enterprise Manager Configuration Assistant, 
refer to "Starting the Enterprise Manager Configuration Assistant" on page 2-4.

Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant, the "Configuration 
Operation" page appears. 

Select "Edit the Configuration Parameters" from the list of configuration operations 
and press Next to Continue. The "Configuration Parameters" page appears.

Step 2 "Configuration Parameters"
Change the parameters you want.

User Name 
Enter the user name of the existing repository which you wish this machine’s 
Management Server to administer. 

Password 
Enter the password for the above user name. The information will be used on the 
next Management Server start up. 

If you change the password, you must also change the Confirm field so that it 
matches the password you changed.

Service
Enter the service where the repository resides. 

This information will be used when this machine’s Management Server next starts 
up. If any of the information is invalid, then the Management Server will not start 
successfully.
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Do not save username and password
You can choose whether to save the user name and encrypted password in the 
omsconfig.properties file, which is read by the Management Server on 
startup. If the user name and encrypted password are stored in the file, the 
Management Server uses them to login to the repository; if they are missing, the 
Management Server prompts you for the user name and password before it starts 
up.

If you do not want to save the user name and password, check the "Do not save 
username and password" checkbox. 

Step 3 "Modify Configuration Parameters"
The "Modify Configuration Parameters" page provides a summary of all the 
information supplied during the modify configuration parameters wizard 
operation. Click Finish to initiate the change or click Back to return to previous 
pages to change your information.

Note: In order to progress to the next page, you must change at least 
one of the parameters in this page. If the Next button is pressed without 
changing anything, an error message appears: "There were no changes to 
the configuration parameters. Make changes or cancel." In this case, the 
Enterprise Manager Configuration Assistant does not allow navigation 
to the next page.
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Starting the Intelligent Agent

Oracle Intelligent Agents are processes running on remote nodes in the network. 
Oracle Enterprise Manager uses Intelligent Agents to discover services on the node 
where it resides and to run jobs, monitor events, and collect data on remote sites. 
Refer to the Oracle Intelligent Agent User’s Guide for detailed information about 
troubleshooting any Intelligent Agent problems.

Intelligent Agents local to the Management Server will be discovered automatically 
when the Management Server is started. In order to discover distributed services, 
the Intelligent Agents on the nodes where those services reside must be started. 

This chapter discusses the following topics:

■ Starting and Stopping the Oracle Intelligent Agent on Windows NT

■ Starting and Stopping the Oracle Intelligent Agent on UNIX

Please check the Intelligent Agent compatibility matrix in the Oracle Enterprise 
Manager Readme before installing or using Enterprise Manager. emreadme.wri or 
emreadme.html is located in the ORACLE_OEM_HOME\RelNotes\EM directory. 
For example, C:\Oracle\Ora81\RelNotes\EM.
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Starting and Stopping the Oracle Intelligent Agent on Windows NT
This section contains information on controlling the Intelligent Agent through the 
Windows NT Control Panel and the command prompt.

Starting the Intelligent Agent on Windows NT
To start the Intelligent Agent on Windows NT, perform the following steps:

1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>Agent service.

3. Click the Start push-button to start the Intelligent Agent.

The Intelligent Agent Startup Type is set to Automatic, which allows the Intelligent 
Agent to start automatically whenever you start the system. If you want the 
Intelligent Agent to be started by a user, set the Startup Type for Manual.

1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>Agent service.

3. Click the Startup push-button. A Service Startup dialog box appears.

4. Choose Manual under the Startup Type.

5. Click OK on the Service Startup dialog box.

Stopping the Intelligent Agent on Windows NT
To stop the Intelligent Agent on Windows NT, perform the following steps:

1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>Agent service.

3. Click the Stop push-button to stop the Intelligent Agent.

Note: Oracle Enterprise Manager and the Intelligent Agent use Net8 to 
communicate with the databases. Verify that Net8 can connect to every 
SID in question before attempting to use the Intelligent Agent.
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Verify Intelligent Agent is Running on Windows NT
To verify that the Intelligent Agent is running, look for its status in the control panel 
services or type net start at a command prompt. 
Oracle<Oracle_Home_Name>Agent should appear in the list of services. 

You may also view the NT Task Manager to see the dbsnmp.exe process 
information.

Starting, Stopping, and Verifying the Status from the Command Prompt
To start or stop the Intelligent Agent from the command prompt, enter the 
appropriate command. From the command prompt, you can also verify that the 
service is running. 

If you want to... Enter the following command

Start the Intelligent Agent from the prompt net start Oracle<Oracle_Home_Name>Agent

Stop the Intelligent Agent from the prompt net stop Oracle<Oracle_Home_Name>Agent

Verify status of the Intelligent Agent from 
the prompt

net start

Note: Do not use the lsnrctl command to start the Intelligent Agent 
for Windows NT. It is not supported. Use the net command for 
Windows NT instead.
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Starting and Stopping the Oracle Intelligent Agent on UNIX
On UNIX, Oracle Enterprise Manager uses the lsnrctl to start and stop the 
Intelligent Agent. The relevant lsnrctl commands to control the UNIX Intelligent 
Agent are listed in the table below.

If you want to... Enter the command...

Start the Intelligent Agent on UNIX platforms lsnrctl dbsnmp_start

Stop the Intelligent Agent on the UNIX platform lsnrctl dbsnmp_stop

Verify status of the Intelligent Agent lsnrctl dbsnmp_status

Note: You must always start and stop the Intelligent Agent as the same 
operating system user.
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Setting Up the Console

The Oracle Enterprise Manager Console is a graphical interface for administrators. 
From the Console, you can perform the following tasks:

■ Centrally administer, diagnose, and tune multiple databases

■ Manage Oracle products and services other than databases

■ Effectively monitor and respond to the health of your Oracle family of products 
and third-party services 24 hours a day

■ Schedule jobs on multiple nodes at varying time intervals

■ Monitor networked services for events

■ Customize your display by organizing databases and other services into logical 
administrative groups

This chapter discusses the topics listed below:

■ Starting the Enterprise Manager Console

■ Discovering Services

■ Creating Administrator Accounts

■ Running Oracle Enterprise Manager from a Web Browser

■ General Setup
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Starting the Enterprise Manager Console
The Console gives you a central point of control for the Oracle environment through 
an intuitive graphical user interface (GUI) that provides powerful and robust 
system management. 

After you have created a repository and started your Management Server and 
Intelligent Agent, you are ready to start the Enterprise Manager Console. 

To start the Enterprise Manager Console, perform the following steps.

1. Start the Enterprise Manager Console. 

■ On Windows platforms:

From the Start menu -> Oracle-<Oracle_Home_Name> -> Enterprise 
Manager, select Console.

■ On UNIX:

At the command line, enter

oemapp console

The command string is case-sensitive and must be entered with lowercase 
characters. 

The Oracle Enterprise Manager Login screen appears, prompting you for your 
administrator name and password.

2. If you are logging in to Oracle Enterprise Manager for the first time, type in the 
default credentials (administrator name and password). 

Administrator = sysman 

Password = oem_temp 

These credentials are for the default super administrator account. The first time 
you start Enterprise Manager, you must login as the super administrator. After 

Note: You can also start Enterprise Manager from a web browser. Refer 
to "Running Oracle Enterprise Manager from a Web Browser" on page 
6-6 for information on installing the Enterprise Manager web site and 
setting up your web browser to run Enterprise Manager.
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other administrator accounts have been created using the super administrator 
account, you can login as a different administrator.

3. Select the name of the node where the Management Server is running from the 
pull-down list. The Management Server on the node you select must be one 
which is configured with the repository you want to access.

If the name of the node where the Management Server is running does not 
appear in the pull-down list, follow the instructions below: 

a. Click the Management Servers button, which is located to the right of the 
Management Server field. The Management Servers dialog appears. 

b. Click the Add button. The Add Management Server dialog appears. 

c. Type in the name of the node where the Management Server is running and 
click OK. 

d. Select the name of the node where the Management Server is running from 
the pull-down list.

4. After the initial login, a security login dialog appears where you can change the 
default super administrator password. You should change the password 
immediately. 

If you are starting the Console for the first time, the Discovery Wizard appears to 
facilitate the process of identifying network services and populating the Console 
Navigator tree.

Note: You must have the Management Server installed and configured 
before performing this step.

Note: Passwords must have no more than 8 characters. 
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Discovering Services
Oracle Enterprise Manager provides a service Discovery Wizard for identifying 
network services and populating the Console Navigator tree. These services, such 
as databases and listeners, can then be administered with Enterprise Manager 
components. 

During start up of the Management Server, the Intelligent Agent and the 
manageable services on the machine where the Management Server is running are 
automatically discovered if the Intelligent Agent is running. The Console Navigator 
then displays all the discovered services on the Management Server machine. 

To discover a remote node: 

1. Select the Discover Nodes item from the Console’s Navigator menu. 

2. When the Discovery Wizard appears, read the introduction text and press Next 
to continue. 

3. When the Specify Nodes page appears, enter the name of the node or the IP 
address in the text window. You can also discover services on multiple nodes at 
one time by entering each node or IP address you want to discover separated by 
a space, comma, tab, or new line within the text window. Then click Next to 
continue.

4. A Progress page appears, showing you the status of the node discovery. A 
checkmark indicates that the node was discovered successfully. An X indicates 
that the discovery has failed. After the discovery process has completed, press 
the Finish button. 

5. A Discovery Results dialog appears, telling you which nodes have or have not 
been automatically discovered. Press the OK button to dismiss the dialog. 

If nodes have failed automatic discovery, you can press the Next button on the 
Progress page. On the Errors page, you will have the option to retry, skip, or 
perform a manual discovery on the failed nodes.

Note: Manually discovered nodes must be dropped from the Navigator 
tree before they can be automatically discovered.
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If a node cannot be discovered, check and see if the node is down or if the node 
does not have an Intelligent Agent running. You can also check to see if you are 
using the TCP/IP network protocol. See the Oracle Enterprise Manager 
Administrator’s Guide for information on discovering services. 

Creating Administrator Accounts
Enterprise Manager Release 2.1 is a multi-administrator system: every person who 
is administering systems using Enterprise Manager has his or her own 
administrator account which he or she uses to log into the Console or standalone 
application.

The installation of Enterprise Manager creates a single default super administrator 
account. This super administrator account name is sysman, and the initial 
password is oem_temp. 

The super administrator sysman has the ability to create administrators using the 
Manage Administrators item in the System menu. In addition to a username and 
password, each account can be tagged as a "super administrator" account or a 
"regular" account. 

Super administrators automatically have full privileges for all objects. Most super 
administrators also have a separate account for daily operations but use their super 
administrator account for special operations only available to super administrator, 
such as starting and stopping the management server or creating new Enterprise 
Manager administrators. 

Regular Administrators can have full access to all other Console operations but they 
will only see or be able to modify those jobs, events, or groups to which they have 
access.

See the Oracle Enterprise Manager Administrator’s Guide for information on how 
Enterprise Manager administrators are created, edited, and deleted with the 
Manage Administrators item in the Console System menu. 

Note: Using the sysman account for routine administration tasks is not 
recommended.
                                                          Setting Up the Console 6-5



Running Oracle Enterprise Manager from a Web Browser
Running Oracle Enterprise Manager from a Web Browser
With Oracle Enterprise Manager Release 2.1, an administrator is not limited to 
managing services from a particular machine. Instead, the administrator has a 
choice to run Oracle Enterprise Manager as a "fat" or "thin" client.

A "fat" client uses Oracle Enterprise Manager files which are installed locally. A 
"thin" client uses a web browser to connect to a webserver where Oracle Enterprise 
Manager files are installed. Functionality available from both types of clients is 
identical. That is, administrators are able to perform the same administrative tasks 
from either a "fat" client or a "thin" client. However, not all components in the 
Oracle Enterprise Manager product family support being run in a web browser. 
Refer to the table below for details.

Note: Browser-based Oracle Enterprise Manager is supported on the 
following operating systems: Windows NT, Windows 95, and Windows 
98

Products
Runs in a 
Browser

Does Not Run 
in a Browser

Oracle Enterprise Manager Console X

Oracle DBA Management Pack X

Oracle Advanced Events available with the Oracle Diagnostics Pack or 
the Oracle Management Pack for Applications

X

Oracle Tuning Pack X

Oracle Diagnostics Pack X

Oracle Change Management Pack X

Oracle Management Pack for Oracle Applications X

Oracle Management Pack for SAP R/3 X

Oracle Standard Management Pack X

Oracle Parallel Server Management (integrated application) X

Oracle Application Manager (integrated application) X
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In order to run Oracle Enterprise Manager from a web browser, you must perform 
the following installation and configuration steps.

1. Install the web browser.

Supported web browsers are listed below:

■ Netscape Navigator® 4.6 on Windows NT, Windows 95, and Windows 98

■ Microsoft® Internet Explorer 5.0 on Windows NT, Windows 95, and 
Windows 98

2. Install the Oracle Enterprise Manager Web Site.

The Oracle Enterprise Manager Web Site is installed: 

■ By default with the top level component Oracle8i Management 
Infrastructure and its install type Oracle Management Server. In this case, 
the Oracle Application Server Listener is installed automatically.

■ Through the custom install type of the top level component, Oracle8i 
Enterprise Edition or Oracle8i Management Infrastructure. Through the 
custom install, the Oracle Application Server Listener is selected by default, 
but you can deselect it and use a different webserver if you want.

The files for the Oracle Enterprise Manager Console, DBA Management Pack, 
some integrated applications, Quick Tours, documentation, and readmes are 
installed with the Oracle Enterprise Manager Web Site.

Note: Oracle Parallel Server Management and Oracle Application 
Manager are the only integrated applications which support being run 
from a web browser.

Note: Using Microsoft® Internet Explorer when it is run from a 
Microsoft® Active Desktop is not supported.
                                                          Setting Up the Console 6-7



Running Oracle Enterprise Manager from a Web Browser
3. Install and configure the webserver.

If you have installed the Oracle Application Server Listener, the web site is 
automatically configured. Once the web site and listener are installed, you only 
need to enter the URL.

You can start the Oracle Application Server Listener for both Windows NT and 
Solaris from the command line using the command:

emwebsite start

You can stop the Oracle Application Server Listener for both Windows NT and 
Solaris from the command line using the command:

emwebsite stop

If you want to use another webserver, the supported webservers are listed 
below:

■ Apache 1.3.9 on Solaris 

■ Oracle Application Server 4.0.8 on Windows NT and Solaris

■ Internet Information Server (IIS) 4.0 on Windows NT

For information on configuring the above webservers, refer to Appendix E, 
"Configuring the Webserver and Directory Mapping".

After performing the above steps, you are ready to run the browser-based Oracle 
Enterprise Manager.

Note: In order to run Enterprise Manager from a web browser, you 
must remove any proxies that are configured for use by your web 
browser. You can do this by either:

■ Choosing to connect directly to the network using the web browser’s 
proxy setting, or

■ Choosing to manually configure the proxy, but specify not to use the 
proxy for the webserver that runs the Enterprise Manager web site.

If you should experience problems with the proxies, refer to 
"Troubleshooting the Web Browser" on page C-16.
6-8 Oracle Enterprise Manager Configuration Guide                              



Running Oracle Enterprise Manager from a Web Browser
1. Launch your web browser and enter the following URL regardless of which 
webserver you have installed.

http://<webserver hostname>:<port number>/
oem_webstage/EMWebSite.html.

For example:

http://jfox-sun:3339/oem_webstage/EMWebSite.html

An index page appears, allowing you to launch various products, 
documentation, and web sites.

2. On this index page, enter the machine name for the Management Server to 
which you want to connect and click the application icon or name of the 
application you want to launch.

Note: The Oracle Application Server Listener port number is 3339.
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If you are entering the URL for the first time, you must install Oracle JInitiator 
Release 1.1.7 or higher plug-in. 

■ On Netscape, you are automatically prompted to install the plug-in. 

■ On Microsoft Internet Explorer, you must enter the following URL to install 
the plug-in:

http://<webserver hostname>:<port number>/
oem_webstage/java-plugin/install_win32.html

3. Follow the instructions on the plug-in page to install the plug-in. Installing the 
plug-in may take several minutes depending on your machine and network 
environment.

Once the java plug-in is installed, the Oracle Enterprise Manager Login dialog 
will appear.

4. If you are logging in to Oracle Enterprise Manager for the first time, type in the 
default credentials (administrator name and password). 

Administrator = sysman 

Password = oem_temp 

Note: Once you are prompted to install the plug-in and you exit or 
cancel, you will no longer be prompted to install it the next time you 
launch the browser-based Enterprise Manager. In this situation, to install 
the plug-in, enter the URL: 
http://<webserver hostname>:<port number>/oem_webstage/java-plugin/

install_win32.html.

Note: Launching the browser-based Oracle Enterprise Manager for the 
first time may take several minutes, and if you are running a dial up 
connection, download times will typically be longer and vary based on 
the line speed.
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These credentials are for the default super administrator account. The first time 
you start Enterprise Manager, you must login as the super administrator. After 
other administrator accounts have been created using the super administrator 
account, you can login as a different administrator.

5. Bookmark the URL. 

General Setup
This section includes information about setting up the Console for jobs, email and 
paging notification, and remote SYSDBA management:

■ Setting Up the Job System

■ Setting Up Email Notification

■ Configuring and Starting the Paging Service

■ Configuring the Console If Using a Dialup Line to Connect to the Management 
Server

■ Configuring a Remote Database for Backup or SYSDBA Administration

Note: If you are not able to connect to the Management Server 
specified, you must return to the EmWebSite.html page to enter a 
different Management Server machine name. You cannot simply enter a 
new Management Server machine name at the Oracle Enterprise 
Manager Login screen.
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Setting Up the Job System
This section contains the following topics:

■ Creating a Windows NT User Account for Running Jobs

■ Setting Up Preferred Credentials for Managed Services

Creating a Windows NT User Account for Running Jobs
In order for the Intelligent Agent to execute jobs on a managed node

■ an NT user account must exist that has the advanced user right, "logon as batch 
job." The privilege can be assigned to an existing local or domain user, or a new 
NT user.

■ the preferred credentials for the node must be set for that user in the Oracle 
Enterprise Manager console. Refer to "Setting Up Preferred Credentials for 
Managed Services" on page 6-16.

■ the user must have read/write permissions to ORACLE_HOME\NET80 directory 
as well as write permissions to the TEMP directory or the ORACLE_HOME 
directory. 

Creating a Windows NT user account is required to permit many of the components 
to allow the Intelligent Agent node to submit jobs to the server node.

You must create a Windows NT user account for every managed node. Follow one 
of the three procedures listed below.

Note: If you do not set up the "logon as batch job" privilege, you will 
receive the "Failed to authenticate user" message when you run jobs on 
the node.
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Creating a New Windows NT User Account  To create a new Windows NT user account 
on the Windows NT machine where the Intelligent Agent is installed and grant the 
"log in as batch jobs" privilege to this user, perform the procedure below.

1. Select the User Manager from the Administrative Tools via the Windows NT 
Start Menu. See the Windows NT documentation for information on the tools.

2. Select New User from the User menu and check for the following:

■ The "User Must Change Password at the Next Logon" option box is not 
checked

■ "SYSTEM" or "system" is not used for the user name.

3. Under the Policies menu of the User Manager NT utility, select the User Rights 
option.

4. Check the "Show Advanced User Rights" box.

5. Select "Logon as a batch job" from the list of privileges.

6. Give the selected user this privilege.
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Assigning Privileges to an Existing NT User Account  Alternately, to assign privileges to 
an existing local user account, perform the following steps.

1. Choose the user on the User Manager panel and check for the following:

■ The "User Must Change Password at the Next Logon" option box is not 
checked

■ "SYSTEM" or "system" is not used for the user name.

2. Under the Policies menu of the User Manager NT utility, select the User Rights 
option.

3. Check the "Show Advanced User Rights" box.

4. Select "Logon as a batch job" from the list of privileges.

5. Add the advanced user right to this user.

6. Click the Add button.

a. Fill in the "List Names From" field: (choose your domain)

b. Click Show Users button.

c. In the listbox, choose the domain user.

d. Click Add.

e. Click OK.

7. In the User Rights Policy window, click OK.
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Configuring a NT Domain User as Your Intelligent Agent User  

Alternately, to configure a domain user as your Intelligent Agent user, perform the 
following steps.

1. Under the Policies menu of the User Manager NT utility, select the User Rights 
option.

2. Check the "Show Advanced User Rights" box.

3. Select "Logon as a batch job" from the list of privileges.

4. Click the Add button.

a. Fill in the "List Names From" field: (choose your domain)

b. Click Show Users button.

c. In the listbox, choose the domain user.

d. Click Add.

e. Click OK.

5. In the User Rights Policy window, click OK.

Note: The NT Domain User works only if the machine is a primary 
domain controller (PDC); otherwise, jobs will fail with VNI-2015 
"authentication error." In all non-PDC environments the account must be 
local to the machine.

Note: If you have both a local and a domain user with the same name, 
the local user takes precedence.

Note: If you have a domain user set up, you must set the domain 
password to be the same as the local password in order for scheduled 
jobs to run when they are submitted using the domain user account. 
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Setting Up Preferred Credentials for Managed Services
In order for the Intelligent Agent to execute jobs or monitor for events on a 
managed node, each administrator must specify valid credentials for the services 
running on that node. Preferred credentials are set from within the Console for each 
managed service.   

To set preferred credentials in the Console, follow the steps outlined below:

1. Select System > Preferences > Preferred Credentials to view the services 
available for management using the Intelligent Agent. 

2. For each managed service that requires authentication, enter the appropriate 
credentials for the service, such as username, password and role. 

3. If some services of a particular type require the same credentials, use the 
<DEFAULT> credentials selection for that service type to have those credentials 
used by all services of that type. 

For example, if Administrator_1 has a username and password of 
admin1/pass1 on all the databases that he manages, he only needs to enter 
admin1/pass1 as his credentials in the <DEFAULT> database entry. All 
databases administration tasks will use these <DEFAULT> credentials. 

Furthermore, if he has just one database which requires different credentials 
from admin1/pass1, he can enter different credentials for that database by 
selecting that specific database. 

The Intelligent Agent authenticates the user name and password for all jobs and 
many events that it runs. If you have not set the preferred credentials correctly, jobs 
and events may fail.   

For NT users, you must set the preferred credentials for the node (where the NT 
Intelligent Agent resides) to be the same as the user that is set up to "Logon as a 
batch job." 
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Setting Up Email Notification

Setting Up the SMTP Gateway
Oracle Enterprise Manager supports sending email notifications using SMTP. To 
allow administrators to use email for notification, you must specify the SMTP mail 
gateway that is used for the SMTP email system. 

SMTP is a TCP/IP-based mail protocol and requires that TCP/IP services are set up 
on the Console machine.

From the Enterprise Manager Console, select Configure SMTP Gateway from the 
System menu and supply the following information. 

If you do not specify the above information, when an administrator tries to 
configure his email notification, an error message will appear.

Setting Up Email and Paging Notifications
Then, each administrator must define preferences for his or her own email or 
paging notifications. From the Enterprise Manager Console, select Preferences from 
the System menu. The Edit Administrator preferences property sheet appears. 

Complete this property sheet page to set up paging and email notification methods 
for the administrator. You can also send a test page or email with the Test options on 
this page.

Field Description

SMTP Mail Gateway: Enter the name of the machine on which the SMTP mail gateway 
resides, such as mailserver.company.com.

Sender’s SMTP Mail 
Address:

Enter the sender name you want to identify yourself as, such as 
Enterprise Manager Mail. Note: Some SMTP servers cannot 
process spaces. If that is the case with your environment, then 
use quotes, such as "Enterprise Manager Mail". The name 
specified will then appear as the sender of the email notification.
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Paging Information

Email Parameters

Item Description

Carrier: After a node containing paging services has been discovered, 
select the name of the paging carrier service from the pull-down 
list. 

Pin: Enter the paging personal identification number (PIN) for your 
page. A PIN is only required for alphanumeric pagers, and not 
for numeric pagers. This entry is required for the GSM, TAP, and 
FLEXTD protocols for alphanumeric pagers. For GSM, the PIN is 
the actual phone number of the administrator. For numeric 
pagers, enter the pager number.

Test: To test the validity of the paging information, select the paging 
service from the pull-down menu, enter the PIN number (if 
needed), and click the Test button. A message appears informing 
you of the status of the page.If the test fails, check the paging 
services configuration file (paging.cfg). Refer to "Configuring 
and Starting the Paging Service" on page 6-20 for explicit 
instructions on paging setup and configuration. You can also 
view the paging trace log file in the 
ORACLE_HOME\sysman\log directory if tracing is enabled for 
paging on the machine which has the Intelligent Agent Paging 
Extensions.

Item Description

Receiver’s Mail: Enter the email address of the administrator to whom email 
notification will be sent. 

Test: Click the Test button to check the validity of the mail 
information. A message displays to inform you of the status of 
the test email. If the test fails, check the email configuration. If 
tracing has been enabled for the Management Server, you can 
also view the mail trace log file in the 
ORACLE_HOME\sysman\log directory.

Subject Prefix: Enter an optional prefix that is added to the email notifications. 
This allows you to further differentiate notifications from the 
Enterprise Manager Console that are sent to administrators.
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Event Notification Filter
The Event Notification Filter allows you to filter email/pages sent to administrators 
according to the event’s level of severity. Filtering is set at the user level through 
Administrator Preferences dialog. You can select any combination of the following 
levels of event severity. Selecting all levels of severity provides no filtering.

■ Alert

■ Warning

■ Clear

■ Node Down

■ Reassign

Job Notification Filter
The Job Notification Filter allows you to filter email/pages sent to administrators 
according to job status. As with the Event Notification Filter, filtering is set at the 
user level through the Administrator Preferences dialog. Selecting all job statuses 
provides no filtering. 

■ Start

■ Complete

■ Fail

■ Delete (Job removed)
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Configuring and Starting the Paging Service
If you want to be notified via paging in Oracle Enterprise Manager, you must 
explicitly install the Paging Service Agent Extensions. This paging service is not 
installed as part of the base Oracle Enterprise Manager installation; it is installed 
with the Oracle Intelligent Agent. Refer to the installation guide provided with the 
database release for more details.

Only one paging service installation is required if you wish to utilize paging for 
notification purposes within Oracle Enterprise Manager. 

The paging service supports either numeric or alphanumeric pagers and utilizes the 
following paging service protocols (for alphanumeric pagers only).

■ TAP (Telocator Alphanumeric Protocol) and 

■ GSM (Global System for Mobile Communications)

■ FLEXTD

Configuration of the paging service is not automatic. Follow the steps below to 
configure paging.

Note: Paging Service Agent Extensions are only supported on 
Windows NT.
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Setting Up Paging
On the machine from which you want to run the paging service, follow these 
instructions: 

1. Install a modem. 

2. Specify modem settings. 

a. Go to Start > Settings > Control Panel > Modems. 

b. Specify how your calls are dialed by clicking Dialing Properties from the 
Modems Properties page and then setting the following parameters: 

* From what area code you are dialing 

* From what country you are dialing 

* How you access an outside line. If you are not required to dial a 
number to access an outside line, leave this field blank. 

c. Set the Maximum Speed parameter by clicking Properties from the Modems 
Properties page. Oracle recommends setting this parameter to 9600K Baud; 
however, you should find the baud rate setting optimal for your system. 

3. Install the Paging Service Agent Extensions. Refer to the installation guide 
provided with the database release for information. 

4. The installation of the Paging Service Agent Extensions provides a template 
configuration file, paging.cfg.template, located in the 
ORACLE_HOME\sysman\config directory. Review this template, which 
contains detailed instructions and examples on how to define the configuration 

Note: You must have a modem installed on the Windows NT machine 
that you are running the paging service.

Note: A baud rate higher than 9600 baud may result in the loss of data 
with the paging service carrier. The baud rate of 9600 baud for your 
modem is only a recommendation. You must find the baud rate setting 
which is optimal for your system.
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properties specific to your carrier and service provider for configuring your 
paging service. 

5. Copy the paging.cfg.template file to the paging.cfg file, which is also 
located in the ORACLE_HOME\sysman\config directory. This is the Oracle 
Home of the database where the Intelligent Agent is installed. Oracle 
recommends copying this file (not renaming it) in order to retain paging 
configuration information. If you do not copy this file, all comments concerning 
paging configuration will be removed. In addition, when updates to Enterprise 
Manager software are made, any configuration will be lost and not retrievable. 

6. Based on the instructions in the paging.cfg.template file, modify the 
paging.cfg file according to your paging needs and save it. Refer to the 
Table 6–1, "Paging Configuration Properties" for summary information about 
the paging configuration properties. The paging.cfg.template file 
contains 14 properties, but not all of these properties require a value and certain 
properties are only applicable to certain types of pagers (numeric or 
alphanumeric).

7. Restart the Intelligent Agent. 

a. Go to Start > Settings > Control Panel > Services. 

b. Select the Oracle<ORACLE_HOME_NAME>Agent service, click Stop and 
then click Start.

 

On the machine from which you run the Management Server, follow these 
instructions: 

8. Ensure the Oracle Management Server is running. If it is not running, you must 
start it. 

a. Go to Start > Settings > Control Panel > Services. 

b. Select the Oracle<ORACLE_HOME_NAME>ManagementServer service 
and click Start. 

Note: Whenever paging configuration changes are made (additions or 
deletions), the Intelligent Agent must be restarted.
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Note: Configuring the paging service is independent of the 
management server. Only when you want to start the paging service do 
you require that the management server be up and running.

Table 6–1 Paging Configuration Properties

Property

Can be 
set for 
Numeric 
Pagers

Can be set for 
Alphanumeric 
Pagers Required Comments

CARRIER_NAMES Yes Yes Yes Value cannot contain 
spaces

PAGER_TYPE Yes Yes Yes Value can be either 
NUMERIC or 
ALPHANUMERIC

COUNTRY Yes Yes Yes If dialing a DBA in the 
same country as the 
paging carrier, set value 
equal to that country’s 
country code. 

For example, if dialing 
a DBA in the United 
States and the paging 
carrier is in the United 
States, set value =1. 

If dialing a DBA in 
India and the paging 
carrier is in India, set 
value =91. 

If dialing a DBA in a 
different country as the 
paging carrier, you 
need to obtain not only 
the DBA’s country code 
but also the code for 
dialing out of the 
paging carrier’s 
country.   
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COUNTRY (cont.) For example, if dialing 
a DBA in the United 
States (country code 1) 
and the paging carrier 
is in Brazil (use 00 to 
dial out), you would set 
value =001.

If dialing a DBA in 
Spain (country code 34) 
and the paging carrier 
is in Germany (use 00 
to dial out), you would 
set value =0034. 

Value cannot contain 
any extra punctuation 
or spaces.

AREA_CODE Yes Yes Yes Set value to the DBA’s 
area code. 

Value cannot contain 
any extra punctuation, 
such as parentheses 
( ’( )’ ).

PHONE_NUMBER Yes Yes Yes Set value to the number 
that needs to be dialed 
to send a page. 

This number can be 
either the number of 
the paging carrier or 
the direct number to the 
pager itself (the latter 
case would not have a 
PIN). 

Value cannot contain 
any extra punctuation, 
such as dashes ( ’-’ ), 
periods ( ’.’ ) or spaces.

Table 6–1 Paging Configuration Properties(Cont.)

Property

Can be 
set for 
Numeric 
Pagers

Can be set for 
Alphanumeric 
Pagers Required Comments
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TIMEOUT Yes Yes No Total time taken for a 
page to complete. 
Numeric paging will 
timeout after the 
specified number of 
seconds in the timeout 
property if the page has 
not been completely 
sent. 

Timeout must always 
be greater than the time 
it takes to send a page.

Do not set the timeout 
to a very high value as 
numeric pagers will 
wait for "timeout" 
number of seconds 
before they terminate.

If value is left blank, the 
paging service will use 
the modem’s default 
setting. 

Oracle recommends 
setting the value = 60.

CONNECTION_DELAY Yes No No Set value to the number 
of pauses that will be 
established on the 
phone line before the 
page message is sent. 

The duration of a pause 
is modem-specific and 
typically used when the 
service carrier is not 
fast enough to receive a 
message. 

Table 6–1 Paging Configuration Properties(Cont.)

Property

Can be 
set for 
Numeric 
Pagers

Can be set for 
Alphanumeric 
Pagers Required Comments
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SUFFIX Yes No Yes Set value if your paging 
carrier has a voice 
prompted message.

Use commas as pauses 
to indicate the time to 
wait before choosing an 
option.

For example, if you 
want to establish four 
pauses and press 1 
before sending the 
message, you set value  
=,,,,1

If the voice prompted 
message requires 
pressing pound after 
option selection to start 
sending the message, 
then you set value 
=,,,1#

PROTOCOL No Yes Yes Value can be either TAP, 
FLEXTD, or GSM

OEM.MANAGEMENT_SERVER Yes Yes No Set value only if using a 
remote Management 
Server.

Enter the name of the 
machine where your 
Management Server is 
running. This is the 
Management Server 
you log in to.

OEM.MANAGEMENT
_SERVER=
<oms-hostname>

Table 6–1 Paging Configuration Properties(Cont.)

Property

Can be 
set for 
Numeric 
Pagers

Can be set for 
Alphanumeric 
Pagers Required Comments
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OEM.MANAGEMENT_SERVER (cont.) Notes on Multiple 
Management Servers:

1. You cannot 
configure multiple 
management 
servers in the 
paging.cfg file. 
When paging starts 
up, it will only 
read the second 
one if you have 
entered two 
management 
servers. 

2. Multiple 
management 
servers use the 
same paging 
service regardless 
of what is in the 
paging.cfg file 
because that 
information is 
stored in the 
repository. 

3. If the management 
server listed in the 
paging.cfg were to 
fail in a 
dual-management-
server 
environment, 
paging will 
continue without 
needing to be 
restarted because it 
bound to the listed 
management 
server at start up. 

Table 6–1 Paging Configuration Properties(Cont.)

Property

Can be 
set for 
Numeric 
Pagers

Can be set for 
Alphanumeric 
Pagers Required Comments
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OEM.MANAGEMENT_SERVER (cont.) 4. If the management 
server listed in the 
paging.cfg were to 
fail in a 
dual-management-
server 
environment and if 
at some point the 
other management 
server also fails (or 
the paging service 
fails), the paging 
service will not 
start until you have 
listed the second 
management 
server in the 
paging.cfg file, 
assuming that the 
first management 
server also was not 
restarted at some 
point before the 
failure.

OEM.MANAGEMENT_SERVER.BOOTPORT Yes Yes No Set value only if not 
using default value of 
7771. 

Value needs to be an 
integer. 

Table 6–1 Paging Configuration Properties(Cont.)

Property

Can be 
set for 
Numeric 
Pagers

Can be set for 
Alphanumeric 
Pagers Required Comments
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TRACING.ENABLED Yes Yes No Set value for debugging 
purposes; paging 
service will then track 
what paging is 
occurring by writing 
trace statements for all 
telephone line handling 
and any successes or 
failures. 

Value can be either 
TRUE or FALSE. 

If value =TRUE then 
you must specify a 
value for the property 
TRACEFILENAME and 
a value for the property 
TRACING.LEVEL. 

If value =FALSE then 
you need not specify 
values for 
TRACEFILENAME and 
TRACING.LEVEL.

TRACING.LEVEL Yes Yes No Set value to specify the 
detail of trace 
information to collect if 
tracing is enabled.

Value can be either 5 
(user level which 
collects critical 
messages and error 
messages), 3 (admin 
level which collects 
critical, error, and 
warning messages) or 2 
(level which collects 
maximum trace 
information).

Table 6–1 Paging Configuration Properties(Cont.)

Property

Can be 
set for 
Numeric 
Pagers

Can be set for 
Alphanumeric 
Pagers Required Comments
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TRACEFILENAME Yes Yes No Set value for where to 
write tracing output if 
tracing is enabled. 

Oracle recommends 
setting the value 
=PAGING_LOG.TRC. 

By default, this file is 
located in the 
Intelligent Agent’s 
ORACLE_HOME\
SYSMAN\LOG\ 
directory.

Note: You cannot leave the COUNTRY and AREA_CODE property 
entries blank even if the paging service and the DBA are in the same 
country or if the paging service and the DBA are in the same area code. If 
you leave the entries blank, paging notification will not function. 

Table 6–1 Paging Configuration Properties(Cont.)

Property

Can be 
set for 
Numeric 
Pagers

Can be set for 
Alphanumeric 
Pagers Required Comments
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Example 1
For example, if you have and/or want the following: 

■ numeric paging

■ paging service should register with a remote Oracle Management Server on a 
non-default boot port of 7774 

■ DBA located in Australia (country code 61) 

■ paging service located in New Zealand (use 00 to dial out of country) 

■ DBA’s pager number - with area code - is (800) 555-1234 

■ paging service should establish four pauses before sending the page message 

■ paging service takes 60 seconds to send a page to the paging carrier 

■ paging carrier has voice prompted message and the paging service should 
choose option 1 after four pauses 

■  tracing not enabled 

Your PAGING.CFG file would look like the following: 

CARRIER_NAMES=CARRIER_NUMERIC_PAGER 
OEM.MANAGEMENT_SERVER=nsulliva.us.oracle.com 
OEM.MANAGEMENT_SERVER.BOOTPORT=7774 
CARRIER_NUMERIC_PAGER.COUNTRY=0061 
CARRIER_NUMERIC_PAGER.AREA_CODE=800 
CARRIER_NUMERIC_PAGER.PHONE_NUMBER=5551234 
CARRIER_NUMERIC_PAGER.CONNECTION_DELAY=4 
CARRIER_NUMERIC_PAGER.TIMEOUT=60 
CARRIER_NUMERIC_PAGER.PAGER_TYPE=NUMERIC 
CARRIER_NUMERIC_PAGER.SUFFIX=,,,,1 
CARRIER_NUMERIC_PAGER.TRACING.ENABLED=FALSE 
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Example 2
For example, if you have and/or want the following: 

■ alphanumeric pager with GSM protocol 

■ DBA located in Norway (country code 47) 

■ paging service located in Sweden (use 009 to dial out of country) 

■ DBA’s pager number - with area code - is (800) 666-1234 

■ paging service takes 75 seconds to send a page to the paging carrier 

■ tracing enabled to the maximum level and to write to PAGINGLOG.TRC file 

Your PAGING.CFG file would look like the following: 

CARRIER_NAMES=CARRIER_ALPHANUMERIC_PAGER 
CARRIER_ALPHANUMERIC_PAGER.COUNTRY=00947 
CARRIER_ALPHANUMERIC_PAGER.AREA_CODE=800 
CARRIER_ALPHANUMERIC_PAGER.PHONE_NUMBER=6661234 
CARRIER_ALPHANUMERIC_PAGER.TIMEOUT=75 
CARRIER_ALPHANUMERIC_PAGER.PAGER_TYPE=ALPHANUMERIC 
CARRIER_ALPHANUMERIC_PAGER.PROTOCOL=GSM 
OEM.TRACING.ENABLED=TRUE 
OEM.TRACING.LEVEL=2 
TRACEFILENAME=PAGINGLOG.TRC 

Example 3
If you have the following in your modem settings:

■ Outside line: 5 for local

■ Outside line: 9 for long distance

■ Area Code: 650

■ Location: USA

Your PAGING.CFG file should have the following:

COUNTRY=1
AREA_CODE=650
PHONE_NUMBER=6380899

The number dialed will be 5 6380899.
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If in the modem settings your area code was 210, the number dialed would be 9 1 
650 6380899.

The "1" dialed for long distance is automatically computed based on the area code 
and country settings specified in control panel -> modem -> dialing properties.

Example 4
For example, if you have and/or want the following: 

■ numeric pager

■ DBA located in the US (country code 1) 

■ paging service located in the US

■ DBA’s pager number - with area code - is (650) 645-8989 

■ paging service should establish 4 pauses before sending the page message

■ paging service has voice prompted message and the paging service should 
choose option 1 after 4 pauses, then choose option 3 after 5 pauses.

CARRIER_NAMES=SERVICE1 
PAGER_TYPE=NUMERIC
SERVICE1.SUFFIX=,,,,1#,,,3#
SERVICE1.CONNECTION_DELAY=4
SERVICE1.COUNTRY=1
SERVICE1.AREA_CODE=650
SERVICE1.PHONE_NUMBER=6458989

The above example causes the following number to be dialed:

16506458989 , , , , 1# , , , 3# , , , , 123456
<--number--><-------suffix----><|><--message-->
                                connection Delay

Note: Example 3 is not a complete example.  It only shows how to set 
the COUNTRY, AREA_CODE, and PHONE_NUMBER.

Note: Example 4 is not a complete example and does not include all 
required properties. You must add all necessary properties.
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Starting the Paging Service
Return to the machine from which you want to run the paging service, and follow 
these instructions: 

1. Start the Paging Service. 

a. Go to Start > Settings > Control Panel > Services. 

b. Select the Oracle<ORACLE_HOME_NAME>PagingService and click Start. 

You can also start the paging service by typing the following at a command 
prompt

oemctrl start paging

On the machine from which you run the Enterprise Manager Console, follow these 
instructions: 

2. Log on to the Console. 

3. Discover the Node on which you configured the paging service or refresh 
discovery for that Node. The Paging Service should then appear underneath the 
discovered or refreshed Node as well as under a new Paging Service folder. 

See the Oracle Enterprise Manager Administrator’s Guide for instructions on how 
to perform discovery. 

4. Set paging notification preferences. Each administrator who wants paging 
notification must follow these steps. 

a. Within the Console go to System > Preferences > Notification.

b. Select a paging service Carrier from the drop down list. What is listed here 
depends on what was set in the PAGING.CFG file on the Intelligent Agent 
machine. 

c. Enter the Pin number for your alphanumeric pager. If you have a numeric 
pager, leave this field blank.

d. Test the paging notification by clicking Test. 

See the Oracle Enterprise Manager Administrator’s Guide for instructions on how 
to set up notification preferences.
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5. Set administrator notification schedule. Each administrator who wants paging 
notification must follow these steps. 

a. Within the Console go to System > Preferences > Schedule 

b. Choose when you want to be notified by paging. If you do not select any 
days/hours to be notified by paging, you will never receive a page. 

See the Oracle Enterprise Manager Administrator’s Guide for instructions on how 
to set up the notification schedule.

Querying Status of the Paging Service
To check the paging status, right-mouse click the carrier name to access the Ping 
Paging Service item in the context-sensitive menu. 

Stopping the Paging Service
Stop the paging service from the NT Services Control Panel.

You can also stop paging service by typing

oemctrl stop paging

Paging Status Codes for Numeric Pages
Numeric pages need to be interpreted as follows: 

For job notifications, you will receive a 6 digit number. The first 3 digits indicate the 
job-id. The last 3 digits indicate job status. 

For event notifications you will receive the event ID with the status code. 

The job and event IDs are internal numbers not shown on the Console.

The event status and job status codes are listed as follows:

100 = Job Started 

200 = Job Completed

300 = Job Failed

400 = Job Deleted

500 = Event Cleared

600 = Event Warning

700 = Event Alert
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800 = Event Node Down

900 = Event Unknown

1000 = Event Assignee Changed

If JJJ= job id then, 

JJJ100 => job started for job# JJJ 
JJJ200 => job completed for job# JJJ
JJJ300 => job failed for job# JJJ 
 
For example, if 001100 is displayed on your numeric pager, then you know that job 
id 001 just started. If 001300 appears, then you know job id 001 just failed. 

If EE= event ID then, 

EE500 => event cleared for event # EE

For example, if 7500 is displayed, you know that event number 7 had a status 
change and the status is now cleared.

Configuring the Console If Using a Dialup Line to Connect to the Management Server 

When the Console connects over a dialup line, the Console machine obtains a 
dynamic IP address. This dynamic IP address needs to be sent by the operating 
system (Windows NT, Windows 95, Windows 98) to the application (Console). 

In order that the operating system return the correct IP address, the network 
communication protocol (TCP-IP) needs to be configured to obtain the IP address 
using the Dynamic Host configuration protocol. This setting is specified as follows: 

1. Select Control Panel -> Network 

2. Select Protocols 

3. Select TCP-IP Protocol-> Properties 

Note: DHCP is not supported for Oracle Enterprise Manager on nodes 
running the Management Server or the Intelligent Agent. It is supported 
only on clients.
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IMPORTANT: You must make note of your previous settings in order to return to 
those settings when you connect the same machine to the network via ethernet. 
Copy the Settings specified in IP Address, Subnet Mask and Default Gateway to a 
file. 

1. Select "Obtain an IP address from a DHCP Server." 

2. Apply your changes. 

3. Configure the listener.ora file with the new dynamic IP address obtained 
by the machine. You must add the following entry:

(ADDRESS=
    (PROTOCOL= TCP)
     (HOST= dynamic host name)
     (Port= 1521)
)

4. Connect to the network via your dial-up line. You will now be successfully able 
to launch the console. 

Note: The listener.ora file must be configured when the repository 
is on the dialup line.

Note: If you are not running from a web browser, you may need to 
restart your system after making the changes.
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Configuring a Remote Database for Backup or SYSDBA Administration
Before using one of the backup management wizards or starting up or shutting 
down a database through Oracle Enterprise Manager, you need to set up your 
database for remote SYSDBA management. 

The following procedure outlines the operations you may need to perform on both 
the server and client if they have not been performed already through the Database 
Configuration Assistant. 

Additional Information: Refer to the operating system-specific documentation for 
your Oracle database for the exact name of the password file creation utility for 
your system.

Server Side (NT)
1. From the command prompt, run the ORAPWD executable to create a new 

password file.

$ORACLE_HOME/bin/orapwd file=<fname> password=<password> entries=<users>

where

fname is the name of password file (mandatory),

password is the password for SYS (mandatory),

entries is the maximum number of distinct DBAs and OPERs (optional),

There are no spaces around the equal-to (=) character.

The <fname> will be created in the Oracle_Home/Database directory. 

2. Edit the init.ora file located in the Oracle_Home/Admin/<SID>/pfile 
directory. Add or change the following parameter 
remote_login_passwordfile=exclusive in the init.ora file. 

3. Shut down your database and then restart it from Control Panel > Services.

4. Grant SYSDBA and/or SYSOPER roles to users who will be performing remote 
DBA operations.
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Server Side (UNIX)
1. Login as ORACLE and set your environment variables.

setenv ORACLE_HOME your_oracle_home
setenv ORACLE_SID your_oracle_sid

2. Change to the dbs directory in your Oracle home.

cd $ORACLE_HOME/dbs

3. Run the ORAPWD executable to create a new password 
file.$ORACLE_HOME/bin/orapwd file=<fname> password=<password> 
entries=<users>

where

fname is the name of password file (mandatory),

password is the password for SYS (mandatory),

entries is the maximum number of distinct DBAs and OPERs (optional),

There are no spaces around the equal-to (=) character.

The <fname> will be created in the $Oracle_Home/dbs directory. 

4. Edit the init.ora file. Add or change the following parameter 
remote_login_passwordfile=exclusive in the init.ora file. 

5. Shut down your database and then restart it. 

a. Start SQL*Plus Worksheet. 

b. Log in as a user with the SYSDBA role.

c. Type

shutdown immediate 
startup

6. Grant SYSDBA and/or SYSOPER roles to users who will be performing remote 
DBA operations

Note: This example assumes that you have set up your database as 
ORACLE.
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Migrating a Release 1.x Repository to a

Release 2.1 Repository

The Oracle Enterprise Manager Migration Assistant supports migrating data for 
both Oracle Enterprise Manager and the Oracle Enterprise Manager Management 
Packs. 

This chapter describes methods for migrating multiple Release 1.x repository 
schemas into an existing single "shared" Release 2.1 repository schema. 

An Oracle Enterprise Manager Release 1.x repository schema is not the same as an 
Oracle Enterprise Manager "shared" Release 2.1 repository schema. In Enterprise 
Manager Release 1.x, each administrator had a separate repository schema which 
contained the current view of the network and user-specific information. In 
Enterprise Manager Release 2.1, administrators have accounts within a single 
shared repository schema, and all individual preferences are stored in the 
administrator’s account.

Note: Migration requires that you first create a Release 2.1 repository 
using the Enterprise Manager Configuration Assistant. Migration is 
performed from a Release 1.x repository into an already existing Release 
2.1 repository.

Note: If you do not have a Release 1 repository, skip this chapter.
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The Migration Assistant supports the migration of the following information into 
an existing Release 2.1 repository:

■ discovery information

■ preferred credentials

■ job information

■ event information

■ groups

Note: The Migration Assistant only runs on Windows NT.
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Important Notes

Phases of Migration
The phases for migrating a Release 1.x repository are listed below:

1. Preparing for Repository Migration

a. Create New Release 2.1 Administrators

b. Refresh All Services in the Release 1.x Console

c. Check the Information Currently in the Release 1.x Repository

d. Back Up the Existing Release 1.x Repository

2. Migrating the Repository Using the Migration Assistant

3. Deleting and Deregistering All Active Jobs and Events from the Release 1.x 
Console

4. Confirming a Successful Migration

Note: Before you start migration, you must back up the database and 
the Release 1.x repository to ensure that the current Release 1.x Oracle 
Enterprise Manager environment and Release 2.1 environment can be 
recovered in the event of an unexpected failure.

Note: If you perform any work with Release 2.1 after you have fully 
migrated your Release 1.x repository to Release 2.1, you cannot go back 
to using that repository with Release 1.x. Rolling back to Release 1.x due 
to problems during repository migration to Release 2.1 is supported only 
if you perform the complete set of pre-migration steps and you do not 
begin work in the Release 2.1 environment.
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How the Differences Between Release 1.x and Release 2.1 Impact 
Migration

The repository migration operation changes the existing Release 1.x repository in 
several ways.

Refer to Release 1.x Objects Reference on page 7-23 for a comprehensive list of the 
Release 1.x objects and whether or not they can be migrated to Release 2.1.

Repository
The Oracle Enterprise Manager Migration Assistant migrates Release 1.6.5 
repositories to Release 2.1. If the Oracle Enterprise Manager Migration Assistant is 
run against a release earlier than 1.6.5, that repository is first upgraded to 1.6.5 in 
place, and then the upgraded repository is migrated to 2.1. Oracle Enterprise 
Manager Release 1.2 is the earliest version supported for in-place upgrades to 
version Release 1.6.5. If the target repository version is less than 1.6.5, then after the 
migration it is no longer functional with Oracle Enterprise Manager Release 1.x. 
Before beginning the migration of any repository, first back up the schema and/or 
tablespace.

Preferred Credentials
Username, passwords, and roles are migrated. When migrating multiple Release 1.x 
repositories to a single Release 2.1 repository with one administrator, the first 
preferred credentials migrated for a service which existed in more than one Release 
1.x repository will be the preferred credentials from the first Release 1.x repository 
migrated. 

Groups
In Release 1.x, jobs and events can be registered against a group appear as a single 
job or event on the Console. In Release 2.1, when a job or event is registered against 
a group, a separate job/event object appears in the Console for each service on 
which the job/event is registered. When migrating a job/event registered against a 
group in Release 1.x to Release 2.1, a separate job or event object will appear in the 
Release 2.1 Console for each service within that Group on which the job/event is 
registered.
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Jobs
■ Only active jobs that are not "fixit" jobs and active jobs that fall within the 

Release 2.1 frequency limitations will be automatically submitted to the Oracle 
Enterprise Manager Job System. 

■ If a job named NAME was migrated to a target database where a job was 
already named NAME, it would be renamed to NAME(1) during migration. If 
there already was a NAME(1), it would be renamed to NAME(2), and so on. 

Backup Jobs
If a backup job is running in Release 1.x and you migrate the data, the job appears 
as a tcl job in Release 2.1. Note: Backup jobs in the job library will not be migrated. 
Backup Manager Jobs differ significantly from Backup Tablespace Jobs in the Oracle 
Enterprise Manager Console.

Fixit Jobs
Release 1.x fixit jobs are migrated to the Release 2.1 job library, but are not 
automatically submitted. The Release 2.1 fixit jobs must be resubmitted from the 
Release 2.1 job library manually after migration. A Release 1.x event associated with 
a Release 1.x fixit job is separated and placed in the Release 2.1 event library and 
Release 2.1 job library respectively (not submitted). After migration, you must edit 
the Release 2.1 event in the Release 2.1 event library and reassociate it with the "V2 
manually resubmitted" fixit job. 

Events
■ Only registered events that are not associated with "fixit" jobs and events that 

fall within the Release 2.1 frequency limitations will be automatically 
submitted.

■ If an event named NAME was migrated to a target database where an event 
was already named NAME, it would be renamed to NAME(1) during 
migration. If there already was a NAME(1), it would be renamed to NAME(2), 
and so on. 

■ The Event "Destination Type" must be the same in Release 2.1 to associate a fixit 
job with an event. For example, if you created a Release 1.x event with a 
"Service Type"  "Database" and you had associated it with a Release 1.x Fixit Job 
such as a "Broadcast Message" of "Service Type"  "Node". The Release 1.x event 
and Release 1.x fixit job with different "Service Types" can be associated and 
registered together. In Release 2.1 the "Destination Type" must be the same as 
the fixit job "Destination Type" to associate and register them together. 

If you migrate an event and a fixit job like the above example, you must 
perform a "Create Like..." on the Release 1.x fixit job and change the Release 2.1 
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"Destination Type" of this job to match the "Destination Type" of the Release 2.1 
event.

Event Sets
■ With the Release 1.x architecture, an "event set" is a collection of individual 

events which were registered to a discovered service. In the Release 2.1 
architecture, an "event" is the collection of individual tests. The Release 2.1 
"event" is similar to the Release 1.x "event set." In Release 2.1, the individual 
Release 1.x "events" are now called "tests." Each "test" still has the same 
possibilities and settings as the Release 1.x Events, and an Event can be defined 
in the same way as a Release 1.x Event Set. When migrating Release 1.x Event 
Sets, each Release 1.x event within the event set is migrated to Release 2.1 as a 
separate event.

■ For Release 2.1 Events, frequency, frequency units, and fix it jobs are assigned at 
the "Event" (or top) level. These items were assigned at the Release 1.x "Event" 
(or low) level. If these items are not the same for all Events in a Release 1.x 
Event Set, each Event in the Release 1.x Event Set will be migrated to a separate 
Release 2.1 Event. If these items are the same for all Events in a Release 1.x 
Event Set, the entire Release 1.x Event Set will be migrated to a single Release 
2.1 Event.

Frequency
Frequency options for jobs and events in Release 2.1 differ from those in Release 1.x. 
Jobs or events that have a frequency that is supported in Release 1.x but not 
supported in Release 2.1 must be submitted or scheduled again in the Release 2.1 
environment. For example: Release 2.1 events support polling intervals of 23:59 
hours or less. Release 1.x supports polling intervals greater than 23:59 hours.

Performance Manager/Capacity Planner 
Any number of Release 1.x Performance Manager/Capacity Planner repositories 
can be migrated to the Release 2.1 repository, but each must be associated with its 
own unique Release 2.1 administrator. 

Change Management Pack
■ CAUTION: If you are migrating a Change Manager Release 1.5.5 repository, the 

migration process will first upgrade it to Release 1.6.5 before migrating it. This 
upgrade cannot be reversed, and you will be unable to use Change Manager 
Release 1.5.5 with this repository. You may therefore want to back up the 
Release 1.5.5 repository, and restore it after the migration, in order to continue 
using it with Change Manager Release 1.5.5.

■ Each Oracle Change Management Pack Release 1.x repository that you migrate 
must be migrated to a Release 2.1 repository that contains no change plans or 
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baselines for any of the administrators. If any change plans or baselines exist for 
any administrator, you must delete the plans or baselines before starting the 
Change Management Pack Release 1.x repository migration. If you do not, the 
Change Management Pack migration fails. In this situation, the 
sysman\temp\vobmgr.log file contains messages that identify which 
administrators in the Release 2.1 repository have plans or baselines that must be 
deleted. Use Plan Manager to delete change plans and DB Capture to delete 
baselines.

Expert
The Oracle Expert Release 1.x repository tables are migrated to a Release 2.1 
repository using an Oracle Expert tuning session export/import methodology. All 
tuning sessions under all databases in the Release 1.x repository are exported into 
.xdl files (one per database) and then imported into the Release 2.1 repository under 
the selected Oracle Enterprise Manager user. 

Paging Services
■ Schedule information for a Release 1.x user will not be migrated to a Release 2.1 

Administrator. Each user must define a new paging schedule in the Release 2.1 
environment. 

■ Paging configuration information will not be migrated to Release 2.1. Each user 
must define new paging confirmation information in the Release 2.1 
environment. 

Email Services
■ Schedule information for a Release 1.x user will not be migrated to a Release 2.1 

Administrator. Each user must define a new email schedule in the Release 2.1 
environment. 

■ Email configuration information will not be migrated to Release 2.1. Each user 
must define new email confirmation information in the Release 2.1 
environment. 
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Preparing for Repository Migration
To prepare for a successful migration, you must complete the following procedures:

■ Install Oracle Enterprise Manager Release 2.1. Refer to the installation guide 
provided with the database release for detailed information.

■ Create New Release 2.1 Administrators

■ Refresh All Services in the Release 1.x Console

■ Shut Down the Release 1.x Console and the Release 2.1 Management Server

■ Check the Information Currently in the Release 1.x Repository

■ Back Up the Existing Release 1.x Repository

Create New Release 2.1 Administrators
Using the Migration Assistant, you can migrate a single Release 1.x repository to a 
single Release 2.1 repository or migrate multiple Release 1.x repositories to a single 
Release 2.1 repository.

For both cases, you must first create the new administrators which will have 
Release 1.x repository information migrated to their Release 2.1 account.

Each Enterprise Manager administrator is a separate user in the repository database 
account.

To create new administrators, follow the steps below:

1. Start the Management Server.

See Chapter 3, "Controlling the Management Server" for detailed information 
on starting the Management Server.

2. Log into the Oracle Enterprise Manager Console Release 2.1 using the SYSMAN 
account. See Chapter 6, "Setting Up the Console" for detailed information on 
starting the Enterprise Manager Console.

Note: If you do not create new Release 2.1 administrators, all objects 
migrated are migrated to the SYSMAN account. The SYSMAN account is 
the default super administrator account provided when you install 
Oracle Enterprise Manager Release 2.1.
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3. Select Manage Administrators from the Console’s System menu. The Manager 
Administrator Accounts dialog appears.

4. Click the Add button in the Manage Administrator Accounts dialog. The Create 
Administrator Account dialog appears.

5. Enter a unique username and password for the Enterprise Manager 
administrator and check the access available to the administrator:

For more information on Managing Enterprise Manager Administrators, see the 
Console chapter in the Oracle Enterprise Manager Administrator’s Guide.

Refresh All Services in the Release 1.x Console
Before migration, you must make sure that all services that need to migrate have 
been successfully refreshed by the Release 1.x console. 

Any service that has not been successfully refreshed will not migrate. 

Shut Down the Release 1.x Console and the Release 2.1 Management Server
Shut down the Release 1.x console and the Management Server, if running. The 
remote agents are left running and existing queue files are left intact. 
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Check the Information Currently in the Release 1.x Repository
To ensure that no information is lost during migration, check the information 
currently in the Release 1.x repository. Later, you will use this information as a 
guide to verify whether the information is present after the migration to Release 2.1.

In the V.1x repository, check for the following information:

1. For discovery information, count the number of discovered hosts and services 
in the Release 1.x environment 

2. View the credential information for at least one node

3. For job information, relevant information to note includes the following:

■ number of jobs

■ type of job

■ job state

■ job history information

4. For event information, note relevant information such as the following:

■ number of event groups

■ number of events in each group

■ nodes where each group is registered

■ current state of the event
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Back Up the Existing Release 1.x Repository
The Migration Assistant does not support automatic recovery when an unexpected 
error occurs during the migration. To ensure that the current Release 1.x Oracle 
Enterprise Manager environment and Release 2.1 environment can be recovered in 
the event of an unexpected failure, you should backup both the Release 1.x 
repository and the Release 2.1 repository.

To backup the repository, you may use Enterprise Manager’s Export wizard or the 
EXPORT utility, a base utility shipped with the Oracle database server. For 
information about using Data Management wizards, refer to the Oracle Enterprise 
Manager Online Help.

The following example is from an NT environment running an 8.0 server.

exp user/password@service owner=oemv1schema file=oemv1.dmp

where USER is the username for the Oracle Enterprise Manager repository to be 
migrated and PASSWORD is the password for the user.

In this example, the saved repository is written to oemv1.dmp.

A message appears at the end of the export, telling you whether the export 
completed successfully:

Export terminated successfully without warnings.

For detailed information about the Export utility, refer to Oracle8i Release 2 (8.1.6) 
Utilities.

Note: A repository created under the SYS user cannot be exported. 
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Migrating the Repository Using the Migration Assistant
Follow the instructions for each database in the Release 1.x Oracle Enterprise 
Manager environment you want to migrate.

Start the Enterprise Manager Migration Assistant from the Windows NT Start 
Menu.
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Step 1 "Introduction"
After launching the Migration Assistant, the “Introduction” page appears, 
providing important information about the purpose of the Migration Assistant and 
any preconditions that are required for the migration to be successful. 

Read the introduction; then, press Next to continue. 

If you have one or more system management packs installed, proceed to Step 2 
"Component Selection" on page 7-14.

If you do not have any system management packs installed, proceed to Step 3 
"Source Repository Login" on page 7-15.
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Step 2 "Component Selection"

Choose the repository components that you want to migrate. 

Only installed components are available for selection. If a valid target repository 
does not exist for the component, one will be created.

After you have made your selection, press the Next button to continue.

Note: The Component Selection page only appears if you have one or 
more system management packs installed.
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Step 3 "Source Repository Login"
Login to the database where the Release 1.x repository is located.

Username and Password: You must provide a valid username for the database where 
the Release 1.x repository is located.

Service: Use the standard SQL*Net V2 or Net8 syntax. The service name is the name 
of the database as it appears in the tnsnames.ora file.

Connect As: Connect as "Normal." 

Press Next to continue.

If the information supplied is valid and a valid Release 1.x repository is present, 
proceed to Step 4 "Target Repository Login" on page 7-16.
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Step 4 "Target Repository Login"
Provide the username, the password, and the service name for the new Release 2.1 
repository. 

Username and Password: The Oracle Enterprise Manager username must be the same 
as the username under which the Release 2.1 repository is created. In other words, 
these are the repository schema owner’s credentials. The Oracle Enterprise Manager 
Release 2.1 repository is an Oracle database schema. The user name and password 
is not the Oracle Enterprise Manager user logon.

Service: Use the standard SQL*Net V2 or Net8 syntax. The service name is the name 
of the database as it appears in the tnsnames.ora file.

Press Next to continue.

If you have provided a valid repository name, password, and service for a valid 
Release 2.1 repository, proceed to Step 5 "Administrator Data" on page 7-17. The 
Oracle Enterprise Manager Migration Assistant also informs you through a dialog if 
the information to be migrated already exists in the Release 2.1 repository and if the 
format of the information is different from the format of the Release 1.x information 
and how this information has been converted. 
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Step 5 "Administrator Data"
Specify the Release 2.1 administrator where the information will be migrated. 

Click Finish to initiate the migration process or click Back to return to previous 
pages to change the information.

Note: If you have not created additional Release 2.1 administrator 
accounts, all object migrated will be migrated to the SYSMAN 
administrator account.
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Work in Progress
A Work in Progress window appears, showing your progress. All information in the 
Work in Progress window is logged into the vobmgr.log file, which is located in 
the %oracle_home%\sysman\temp directory.

Note: If you are migrating a Release 1.x repository with the Change 
Management Pack installed but have not yet used a Change 
Management Pack application, the Change Management objects will 
automatically be created in the new Release 2.1 repository.
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Deleting and Deregistering All Active Jobs and Events from the Release 
1.x Console

The repository migration from Release 1.x into the Release 2.1 environment must be 
coordinated. Part of the migration process is to delete and deregister all active 
Release 1.x jobs and events by hand. 

Job and event information defined in the Release 1.x repository is copied to the 
Release 2.1 repository. 

After performing the repository migration, follow the steps outlined below:

1. Start the Release 1.x Console, connecting to the Release 1.x repository that was 
just migrated. 

2. Delete/deregister all active jobs and events manually. If you do not delete and 
deregister active jobs and events, there could be duplicate jobs running at the 
agent. Events will fail to register due to "not unique" errors. 

3. Shut down the Release 1.x Console(s). 

4. Start the Management Server. 

Note: If you migrate information and do not start the Release 1.x 
console and remove jobs and events before starting the Management 
Server; then, the initial start will attempt the registration of events and 
submission of jobs. Jobs will register, but events may fail as the event is 
already registered with the agent from the Release 1.x console (Intelligent 
Agent’s restriction on uniqueness of events). 

The failure will be presented at the console. You can de-register the 
Release 1.x event and attempt the re-registration via Create Like... from 
the failed event registration on the Release 2.1 Console.

Note: You must repeat the same steps to migrate each of the Release 1.x 
repositories into the single Release 2.1 repository.
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Confirming a Successful Migration
After the Migration Assistant has moved the Release 1.x repository information into 
the specified Release 2.1 administrator, login to the Release 2.1 console as that 
administrator and confirm the migration. 

You must ensure that all information is present after repository migration by 
checking that the discovery, preferred credentials, job and event information has 
migrated successfully.

1. For discovery information, check that the hosts and services are represented 
after migration via the Console navigator.

2. Credential information for at least one node should be viewed by using the 
Release 2.1 Console navigator to access the database using the migrated 
credentials.

3. For job information, relevant information to check include the number of jobs, 
the type of job, and the job state, and relevant job history information. Certain 
Release 1.x jobs contain tasks which do not migrate into Release 2.1. These need 
to be taken into account as well. Refer to Release 1.x Objects Reference on page 
7-23 for job tasks that do not migrate.

4. For event information, relevant information to note includes the number of 
events, the number of tests in each event, the nodes where each group is 
registered, and the current state of the event. Refer to Release 1.x Objects 
Reference on page 7-23 for event tests that do not migrate.

5. For the number of Performance Manager recordings and user-defined charts 
which were successfully migrated, check the migration log file, 
sysman\temp\vobmgr.log.

Note: The Migration Assistant does not migrate any manually 
discovered targets.

Note: If the Release 2.1 Console is unable to match the migrated service 
name with the service name stored in the credentials table that the 
Release 1.x Console used, you must reenter the preferred credentials 
through the Release 2.1 Console after migration for the affected service.
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6. For information about the Oracle Expert migration process, check the 
sysman\temp\vobmgr.log file and the more detailed 
sysman\temp\xpomigr.log file.

7. For Change Management you need to count the number of baselines and 
change plans in PlanMan and Capture in Release 1.x and compare the number 
to the number migrated in Release 2.1.
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Backing out of a Migration
In the event of an unexpected problem during the migration, you may need to 
restore the Oracle Enterprise Manager environment to its previous state. To restore 
the Oracle Enterprise Manager environment:

1. Drop the old Release 1.x repository user using DBA Studio’s Security 
Management. Refer to the Oracle Enterprise Manager Online Help for detail 
information about Security Management.

2. Import the saved Release 1.x repository user using Import wizard or the 
IMPORT utility, a base utility shipped with the Oracle database server. The user 
is recreated when you import. For information about using Import wizard, refer 
to the Oracle Enterprise Manager Online Help. The following example uses the 
IMPORT utility.

imp user/password@service file=oemv1.dmp

Importing the schema will "recreate" the Release 1.x repository as it was before 
migration.

For detailed information about the Import utility, refer to Oracle8i Release 2 
(8.1.6) Utilities.

Note: Jobs and events must be reregistered if they have been 
deregistered. 
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Release 1.x Objects Reference
Refer to the sections below for a comprehensive list of the Release 1.x objects and 
whether or not they can be migrated to Release 2.1.

Release 1.x Objects Which Will Migrate to Release 2.1
The following Release 1.x objects can be migrated to Release 2.1:

Preferred Credentials
Username, passwords, and roles are migrated. When migrating multiple Release 1.x 
repositories to a single Release 2.1 repository with one administrator, the first 
preferred credentials migrated for a service which existed in more than one Release 
1.x repository will be the preferred credentials from the first Release 1.x repository 
migrated. 

Services
Databases, Nodes and Listeners are migrated if the status of the last 
discovery/refresh of these services was successful. 

Groups: In Release 1.x, jobs and events are registered against groups as a single 
object. If a job or event is registered to a group in Release 1.x; then, the job or event 
is migrated to Release 2.1 by creating a separate job or event for each service on 
which the job or event is registered. 

The job or event is not migrated to a group since groups are not migrated as a 
logical entity. No group will exist on the Release 2.1 side. All of the Release 1.x 
group members will migrate individually to Release 2.1. The group will need to be 
recreated in Release 2.1, and the migrated members must be added again.
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Jobs

Fixit Jobs

Events

Others

Run DBA Script Startup Database Run TCL

Run SQL * Plus Broadcast Message Shutdown Listener

Shutdown Database Run OS Command Startup Listener

All Schedule Information Override Preferred Credentials Job History

Dependent Jobs Job Library Active Jobs

Alert Probe UpDown 
(Database)

Buffer Cache

Data Dictionary Cache Disk I/O Library Cache Net I/O

SysStat Table SysStat Table Delta Datafile Limit Lock Limit

Process Limit Session Limit User Limit Archive Full

Chunk Small Dump Full Maximum Extents User Blocks

Continued (chained) 
Row

UpDown 
(listener/sqlnet)

UpDown (node) CPU Paging

CPU Utilization Disk Full Swap Full Archiver Hung

Broken Jobs Data Block Corruption Deferred 
Transactions

Error Transactions 

Failed Jobs Session Terminated Unscheduled Jobs Free Buffer

In Memory Sorts Index Rebuild Redo Log 
Allocation

Roll Back Contention

Alert File Large Fast Segment Growth Multiple Extents Snapshot Log Full 

Tablespace Full User Audit Data Gatherer 
Alert

Data Gatherer 
UpDown

Event Set Library Registrations Third Party Events

Fixit Jobs Associated with Triggered Events Frequency Pack Repositories
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Release 1.x Objects Which Need to be Re-created
The following objects need to be re-created:

Jobs

Others

Release 1.x Objects Which No Longer Exist
Release 1.x objects which no longer exist in Release 2.1 are listed below:

Jobs

Events

Others
Maps

Backup Tablespace from 
Oracle Enterprise 
Manager Jobs

Export

Import Load

SNMP Traps Paging Services Email Services

Administrator Lists manually discovered targets

Deinstall Products Delete Package

Distribute Package Install Package

Rdb Database Events Rdb Services Events

Event History Outstanding Events
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Setting Up DBA Studio

The DBA Management Pack features DBA Studio and SQL*Plus Worksheet. 

DBA Studio combines the functionality of multiple database tools and master view 
detail so that you can access database administration features and manage multiple 
databases from one tool:

■ Instance Management: Start or shut down a database, edit database 
initialization parameters, manage resource allocations and users’ sessions.

■ Security Management: Administer users, privileges, and profiles.

■ Schema Management: Create, edit, and examine schema objects.

■ Storage Management: Administer tablespaces, datafiles, rollback segments, and 
redo logs. You can also view controlfile and archive log information.

In previous releases of Enterprise Manager, there were individual database tools 
(Instance Manager, Schema Manager, Storage Manager, and Security Manager) for 
performing the above functions. Should you want to continue using these separate 
independent tools rather than the well-integrated DBA Studio, refer to the 
installation guide provided with the database release for instructions on installing 
them.

DBA Studio can be used to perform your database administration tasks and 
supports versions of Oracle databases back to 7.3.4. Analyze, Backup Management, 
Data Management, Dimension Creation, Summary Advisor, Create Table, and 
Create View wizards are also available.
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This chapter discusses the topics listed below:

■ DBA Studio in Standalone or Management Server Mode

■ Setting Up DBA Studio in Standalone Mode

■ Setting Up DBA Studio in OMS Mode

■ Other DBA Studio Procedures
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DBA Studio in Standalone or Management Server Mode
When you start DBA Studio, you can connect either directly to the databases (in 
standalone mode) or through an Oracle Management Server (in OMS mode). 

Direct Connection to Databases
Run DBA Studio in standalone mode if you want to perform basic administrative 
tasks that do not require the job, event, or group system. If you connect in 
standalone mode, DBA Studio has access to the databases you have set up in a local 
record of databases.

Connection through the Oracle Management Server
Run DBA Studio in OMS mode if you want to:

■ use the Oracle Enterprise Manager framework

■ perform basic administrative tasks that require events or groups 

■ access all databases previously discovered from the Console

■ run DBA Studio through a web browser

■ use the analyze, backup, and data management wizards

If you connect to an Oracle Management Server, DBA Studio has access to all 
databases on the discovered nodes. The Oracle Management Server must be 
running for DBA Studio to connect to it. 

Note: A Management Server and repository are not required if you 
only plan to run DBA Studio connected directly to the databases (in 
standalone mode).
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Setting Up DBA Studio in Standalone Mode
To run DBA Studio in standalone mode, you do not have to have an Oracle 
Enterprise Management Server or repository set up.

To set up DBA Studio in standalone mode, you must perform the following tasks:

■ start DBA Studio

■ add net service names (the databases you want to manage) to the DBA Studio 
navigator tree

■ connect to the database

■ set up local preferred credentials if you want

Starting DBA Studio in Standalone Mode
1. Start the DBA Studio.

■ On Windows NT:

You can start the DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> DBA Management 
Pack->DBA Studio.

You can also start the DBA Studio from the command line using the 
command:

oemapp dbastudio

■ On UNIX:

You can start the DBA Studio from the command line using the command:

oemapp dbastudio

2. When the login dialog appears, choose Connect directly to databases and press 
OK. 

If you are starting DBA Studio for the first time, the left panel of DBA Studio is 
empty because you have not yet added the databases you want to manage. The 
Add Database To Tree dialog appears automatically so that you can add them to the 
navigator tree. 
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Adding Databases to the Tree in DBA Studio Standalone Mode
The Add Database To Tree dialog appears automatically when you start DBA 
Studio for the first time; it is also available from the File menu.

The Add Database To Tree dialog allows you to manually enter the net service 
names or add them from the local tnsnames.ora file.

Add a database manually
You can add databases to the DBA Studio navigator tree by manually filling in the 
following fields:

■ SID: the database system identifier, usually the instance name, such as ORCL

■ Hostname: the machine or node name where the database is located

■ Port Number: the database listener port address, usually 1521 or 1526

■ Net Service Name: A name which uniquely identifies a database when 
connecting to a machine. It is usually the global database name. For example: 
ORCL.world. 
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. 

Add selected databases from your local tnsnames.ora file 
You can populate the DBA Studio navigator tree by reading the database service 
names from the local tnsnames.ora file located in your Oracle Enterprise Manager 
home. The Add Database To Tree dialog displays a list of databases identified in 
you tnsnames.ora file from which you can select or deselect. Click the column 
header to the left of Service Name to either select or deselect all the databases. If 
you have deselected all the databases, you can choose specific databases by 
selecting their checkboxes.

Note: Adding a database manually automatically updates 
the local tnsnames.ora file located in your 
<Oracle_Enterprise_Manager_Home>/network/admin 
directory.

Note: Currently only TCP/IP service names can be manually 
entered.

Note: All protocols are supported when you import selected services 
from your tnsnames.ora file.
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Connecting to a Database in DBA Studio Standalone Mode
There are four ways to connect to a database for DBA Studio:

■ Click the plus symbol next to the DBA Studio navigator tree container

■ Double-click the database icon in the DBA Studio navigator tree 

■ Select the Connect item from the File menu. 

■ Click the Connect icon from the toolbar.

In the Database Connect Information dialog, enter the following information to 
connect to the database.

Username
Your Oracle username for the database to which you are connecting.

For example: system

Password
Your Oracle password for the database to which you are connecting.

For example: manager

Service Name
Network service name for the database to which you are connecting. 

For example: use a Net8 service name, such as orcl.pjlee-pc, which connects to the 
orcl database on the pjlee.us.oracle.com machine.

Connect As
You can select from a pull-down list whether you want to connect to the database 
with NORMAL, SYSOPER, or SYSDBA privileges. Select NORMAL to connect to 
the database as an ordinary user. Select SYSOPER to connect to the database with 
special operator privileges, such as capabilities to shut down and start up the 
database. Select SYSDBA to connect to the database as a user with full database 
privileges such as the capability to grant any privileges to any user.

To use SYSOPER and SYSDBA privileges, a password file or OS group 
authentication must be created and set up for your database.
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Save As Local Preferred Credentials
Saving preferred credentials is an option which enables you to store login 
information in a local file, such as username, password, and role (NORMAL, 
SYSOPER, or SYSDBA). Passwords are always stored in encrypted format. 

This login information is used when a connection is established for the database 
instead of having to type a username and password each time.

You can set preferred credentials by selecting the Save As Local Preferred 
Credentials checkbox or you can use the Edit Local Preferred Credentials dialog 
available from the File menu.

The checkbox is not selected by default. 

Editing Local Preferred Credentials in DBA Studio Standalone Mode
Saving or editing preferred credentials is an option which enables you to store login 
information, such as username, password, and role (NORMAL, SYSOPER, or 
SYSDBA). Passwords are always stored in encrypted format. 

This login information is used when a connection is established for the database 
instead of having to type a username and password each time.

DBA Studio stores a list of databases that are displayed in the DBA Studio navigator 
tree. If preferred credentials are specified for any of these databases, the username, 
encrypted password, and role are added to a local file.

DBA Studio maintains a local record of login credentials separately from the Oracle 
Management Server. 

To save or edit the local preferred credentials of a service, you can perform the 
following steps:

Note: The passwords are encrypted in the local file to prevent the file 
from being used on other machines.

Note: If you cannot edit the local preferred credentials, check to see if 
you are in DBA Studio standalone mode.
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1. From the File menu, select the Edit Local Preferred Credentials item. The Edit 
Local Preferred Credentials dialog displays a list of services.

2. In the Edit Local Preferred Credentials dialog, select the service name of the 
database and enter or update the preferences for connection to that database.

■ Username: Enter the username. This field is required if a password has been 
entered.

■ Password: Enter the password. You can leave this blank if you want to be 
prompted for a password when you connect to the database.

■ Confirm: Confirm the password.

■ Role: Select the role from the pull-down list. You need to login with the 
SYSDBA or SYSOPER role to start up or shut down a database.

3. Click the OK button at the bottom of the Edit Local Preferred Credentials dialog 
to save your updates. 
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Setting Up DBA Studio in OMS Mode
To run DBA Studio in OMS mode, you must already have a repository and a 
Management Server set up and Intelligent Agents started on the nodes where your 
distributed services reside. 

To set up DBA Studio in OMS mode, you must perform the following tasks:

■ set up DBA Studio to connect to a Management Server

■ start DBA Studio

■ connect to the database

Setting Up DBA Studio to Connect to a Management Server
To set up DBA Studio to connect to an Oracle Management Server, follow the 
instructions below:

1. Ensure that the Oracle Intelligent Agents are started on the nodes you want to 
manage. Refer to Chapter 5, "Starting the Intelligent Agent" for information on 
starting your Intelligent Agents.

2. Ensure that the Oracle Management Server is started. Refer to Chapter 2, 
"Creating a Release 2.1 Repository" for detailed information on setting up a 
repository and Management Server and Chapter 3, "Controlling the 
Management Server" for detailed information about starting the Management 
Server.

3. Start the Console. Refer to Chapter 6, "Setting Up the Console" for information 
on starting the Console.

Use the Discovery Wizard to discover the nodes where the desired databases 
reside. Refer to Chapter 6, "Setting Up the Console" for information on 
discovering nodes. DBA Studio will then have access to these discovered 
databases.

Note: You can save or overwrite the preferred credentials by selecting 
the "Save As Local Preferred Credentials" checkbox in the Database 
Connection dialog.
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4. Exit the Oracle Enterprise Manager Console. 

Starting DBA Studio OMS Mode
1. Start DBA Studio.

■ On Windows NT:

You can start DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> DBA Management 
Pack->DBA Studio.

You can also start DBA Studio from the command line using the command:

oemapp dbastudio

■ On UNIX:

You can start DBA Studio from the command line using the command:

oemapp dbastudio

2. When the login dialog appears, choose Login to the Oracle Management Server.

Note: If you want to add databases to the navigator tree for DBA 
Studio connected to an Oracle Management Server, you must use the 
Discovery Wizard from the Oracle Enterprise Manager Console. The 
navigator tree is populated from the repository and cannot be modified 
using DBA Studio.
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3. Enter the credentials for the super administrator account: 

Administrator: sysman or the user the super administrator has created for you

Password: oem_temp or the new password if you have changed it

Management Server: the name of the node where the Oracle Management 
Server is running

4. Press the OK button. DBA Studio appears. The navigator tree is populated with 
the databases discovered through the Oracle Enterprise Manager Console.
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Connecting to a Database in DBA Studio OMS Mode
There are four ways to connect to a database for DBA Studio:

■ Click the plus symbol next to the DBA Studio navigator tree container

■ Double-click the database icon in the DBA Studio navigator tree 

■ Select the Connect item from the File menu. 

■ Click the Connect icon from the toolbar.

If no preferred credentials are set in the Oracle Enterprise Manager Console, the 
Database Connection Information dialog box appears. If preferred credentials are 
already set, you will connect to the database using this login information.

If the Database Connect Information dialog appears, enter the following 
information to connect to the database.

Username
Your Oracle username for the database to which you are connecting.

For example: system

Password
Your Oracle password for the database to which you are connecting.

For example: manager

Service Name
Network service name for the database to which you are connecting. 

For example: use a Net8 service name, such as orcl.pjlee-pc, which connects to the 
orcl database on the pjlee.us.oracle.com machine.

Connect As
You can select from a pull-down list whether you want to connect to the database 
with NORMAL, SYSOPER, or SYSDBA privileges. Select NORMAL to connect to 
the database as an ordinary user. Select SYSOPER to connect to the database with 
special operator privileges, such as capabilities to shut down and start up the 
database. Select SYSDBA to connect to the database as a user with full database 
privileges such as the capability to grant any privileges to any user.

To use SYSOPER and SYSDBA privileges, a password file or OS group 
authentication must be created and set up for your database.
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Save As Preferred Credentials
Saving preferred credentials is an option which enables you to store login 
information in the repository, such as username, password, and role (NORMAL, 
SYSOPER, or SYSDBA). Passwords are always stored in encrypted format. 

This login information is used when a connection is established for the database 
instead of having to type a username and password each time.

The checkbox is not selected by default. 
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Other DBA Studio Procedures
This section discusses the topics listed below:

■ Accessing the Quick Tour in DBA Studio

■ Connecting to the Database As a Different User

■ Viewing Which Role You Are Connected As In DBA Studio

■ Removing a Database from Tree in DBA Studio Standalone Mode

■ Removing a Database from the Navigator in OMS Mode

■ Adding Databases to the Navigator Tree For DBA Studio OMS Mode

■ Changing from OMS Mode to Standalone Mode

■ Changing from Standalone Mode to OMS Mode

Accessing the Quick Tour in DBA Studio
To access the Quick Tour in DBA Studio, you must first highlight a database or any 
of the nodes and click the Quick Tour button in the right-hand window.

Connecting to the Database As a Different User
In DBA Studio you do not have to disconnect in order to reconnect as a different 
user.

If you are already connected to a database and you want to reconnect as a different 
user

■ Right-click the database icon and select Connect from the context-sensitive 
menu. 

■ Select the Connect item from the File menu. 

■ Click the Connect icon from the toolbar.

When the Database Connect Information dialog appears, enter a different username 
and press OK.

You will automatically be disconnected and reconnected.
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Viewing Which Role You Are Connected As In DBA Studio
When a connection is made to a database, a connection icon is displayed on top of 
the database icon in the DBA Studio tree. 

Next to the database name, you can see the username and role you are connected as 
if you have connected with the SYSDBA role. For example, sys AS SYSDBA.

Removing a Database from Tree in DBA Studio Standalone Mode
To remove a database from the DBA Studio navigator tree, follow the steps below:

1. Highlight the database you want to remove.

2. From the File menu, choose Remove Database from Tree item.

3. A message appears, saying, "Remove the <name> database from tree. Are you 
sure?" Click the Yes button. 

Note: Removing the database removes the entry from the DBA 
Studio Navigator tree. It does not remove the entry from the 
tnsnames.ora file or physically remove the database. If required, you 
have the option of adding the database to the navigator tree again.

Note: You can only remove databases from the navigator tree if you 
are connected to DBA Studio in standalone mode.
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Removing a Database from the Navigator in OMS Mode
To remove a database from the navigator tree for DBA Studio connected to an 
Oracle Management Server, you must remove the database from the Oracle 
Enterprise Manager Console.

1. Start the Oracle Enterprise Manager Console.

2. Highlight the node where the database you want to remove resides. 

3. Select the Remove Database item from the Navigator menu. 

4. Exit the Oracle Enterprise Manager Console. 

5. In DBA Studio, choose the Refresh item from the View menu. The node where 
the desired databases reside should disappear in the navigator tree.

Adding Databases to the Navigator Tree For DBA Studio OMS Mode
If you want to add databases to the navigator tree for DBA Studio connected to an 
Oracle Management Server, you must use the Discovery Wizard from the Oracle 
Enterprise Manager Console.

1. Start the Oracle Enterprise Manager Console.

2. Choose the Discover Nodes item from the Navigator menu to launch the 
Discovery Wizard. For more information about service discovery, refer to the 
Oracle Enterprise Manager Administrator’s Guide.

3. Specify the nodes where the desired databases reside and discover them. DBA 
Studio will have access to these databases.

4. Exit the Oracle Enterprise Manager Console. 

5. In DBA Studio, choose the Refresh item from the View menu. The nodes where 
the desired databases reside should appear in the navigator tree.

Note: Do not stop the Oracle Management Server or the Oracle 
Intelligent Agent.
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Changing from OMS Mode to Standalone Mode
When DBA Studio is connected to an Oracle Management Server, the DBA Studio 
navigator tree is populated with the discovered databases from the Enterprise 
Manager Console. 

The following steps describe how to copy these databases so they can be used in 
standalone mode.

The databases displayed in the navigator tree can be added to the tnsnames.ora file 
and their associated preferred credentials saved to a local file:

1. Use the Update tnsnames.ora File dialog from the File menu to select which 
services to copy to the local tnsnames.ora file.

2. If you want to save the preferred credentials to a local file, select the "Save 
Preferred Credentials Locally" checkbox in the Update tnsnames.ora File dialog. 

To make these databases available in standalone mode, you can perform the 
following steps:

1. Start DBA Studio connected directly to databases.

2. From the File menu, select the Add Database To Tree item.

3. In the Add Databases to Tree dialog, select the net service names to add from 
the local tnsnames.ora file.

Note: The passwords are encrypted in the local file to prevent the file 
from being used on other machines.
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Changing from Standalone Mode to OMS Mode
If you have been using DBA Studio in standalone mode, the list of databases 
displayed in the navigator tree is retrieved from a local file. 

At some stage in the future, you may decide to administer jobs, events, and groups; 
run DBA Studio through a web browser; or perform backup and data management 
tasks. These tasks require you to run DBA Studio connected to an Oracle 
Management Server.

If you now decide to run DBA Studio connected to an Oracle Management Server, 
the databases displayed in the navigator tree may be different than those in 
standalone mode, because the list of databases is retrieved from the repository and 
not from a local file. 

To add the databases that were available from DBA Studio in standalone mode, you 
will need to discover the services from the Oracle Enterprise Manager Console if the 
databases are not already available from DBA Studio connected to the Oracle 
Management Server. For more information about service discovery, refer to the 
Oracle Enterprise Manager Administrator’s Guide. 

Note: To switch modes from DBA Studio in standalone mode to 
OMS mode, you need to close and restart DBA Studio.
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Directory Structure

This appendix describes the directory structure that is created when Oracle 
Enterprise Manager Release 2.1 is installed.
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Directory Structure of Oracle Enterprise Manager Release 2.1
The following directories are created when Oracle Enterprise Manager Release 2.1 is 
installed.

Directory Structure for $ORACLE_HOME\sysman
The directory structure for $ORACLE_HOME\sysman is listed below: 

■ $ORACLE_HOME\sysman\admin 

■ $ORACLE_HOME\sysman\config 

■ $ORACLE_HOME\sysman\dbapp

■ $ORACLE_HOME\sysman\log 

■ $ORACLE_HOME\sysman\temp 

■ $ORACLE_HOME\sysman\ifiles 

$ORACLE_HOME\sysman\admin
The $ORACLE_HOME\sysman\admin directory contains SQL scripts and registry 
files that are used by the Enterprise Manager Configuration Assistant. The contents 
must not be altered. 

$ORACLE_HOME\sysman\config
The $ORACLE_HOME\sysman\config directory contains several configuration 
files. Only the following files should be altered by the user:

■ omsconfig.properties

■ clientconfig.properties

■ dbapps.cfg

Any other files in this directory must not be altered. 

Tracing information for the Oracle Enterprise Manager Release 2.1 components is 
stored in the omsconfig.properties and clientconfig.properties files. 

The dbapps.cfg file contains settings for SQL*Plus worksheet. 

The dbapps.cfg is used to specify additional environment variables for SQL*Plus. 
Also, to run SQL*Plus Worksheet in another NLS language, you must specify 
additional environment variables in the dbapps.cfg, like you would do in 
command line sqlplus. 
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By default, the following is set: 

SQLPLUS_ENDOFBUFTOKEN=OEM_sqlplus_input_finished 

$ORACLE_HOME\sysman\log 
The $ORACLE_HOME\sysman\log directory contains the output of traces that are 
redirected to disk. This directory contains the oms.log and oms.nohup files. The 
oms.nohup file contains Management Server error messages which appear before 
the Management Server starts up. The oms.log file contains messages generated 
when the Management Server is starting and running.

$ORACLE_HOME\sysman\temp 
The $ORACLE_HOME\sysman\temp directory contains temporary files that may be 
created in the course of processing management operations.

$ORACLE_HOME\sysman\ifiles 
When you save init.ora parameters to a file while using Instance Management, the 
files are saved to the $ORACLE_HOME\sysman\ifiles directory by default.

Other Important Directories
Other important directories include:

$ORACLE_HOME\RelNotes\EM
All readmes that ship with Enterprise Manager are installed in this directory. 

$ORACLE_HOME\Doc\EM
Documentation in html format that ships with Enterprise Manager is installed in 
this directory. PDF formatted documentation is not installed in this directory. Note: 
For Solaris, the documentation is on a separate CD and is not installed when you 
install Enterprise Manager.
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Configuration Assistant Operations

The Enterprise Manager Configuration Assistant assists the database administrator 
with repository creation, removal, upgrade, and configuration parameter 
maintenance. 

Repository creation is described in "Creating a Release 2.1 Repository" on page 2-1.

 This appendix discusses: 

■ how to upgrade a Release 2.0 repository to a Release 2.1 repository

■ how to drop a repository

■ how to redirect the local Management Server to use a different repository or to 
respond to changes in the repository user’s password

It also includes information about repository creation and parameters configuration 
when the omsconfig.properties file is inaccessible.

If you are using a previous Enterprise Manager Release 1.x release and want to 
migrate your 1.x repository or repositories directly to a Release 2.1 repository, you 
will need to perform additional steps using the Enterprise Manager Migration 
Assistant after creating your Release 2.1 repository. Refer to Chapter 7, "Migrating a 
Release 1.x Repository to a Release 2.1 Repository" for information about migrating 
one or more Release 1.x repositories into the shared Release 2.1 repository schema.

Note: An Oracle Enterprise Manager Release 1.x repository is not the 
same as an Oracle Enterprise Manager Release 2.1 repository. A Release 
2.1 repository may not coexist with a Release 1.x repository in the same 
schema. 
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Upgrade a Release 2.0 Repository to a Release 2.1 Repository

 In order to upgrade a repository, you must connect to the database as a user with 
DBA privileges. 

To upgrade the repository, follow the steps outlined in the following sections.

For information about starting the Enterprise Manager Configuration Assistant, 
refer to "Starting the Enterprise Manager Configuration Assistant" on page 2-4.

Note: If you plan to upgrade your repository from Release 2.0 to 
Release 2.1, you must first upgrade your products to Release 2.1 before 
upgrading your repository. 

The Oracle Enterprise Manager Configuration Assistant takes an existing 
repository and upgrades it directly. After the upgrade, the original 
repository is at the newer version.

It is necessary for all users of the repository to upgrade all their Oracle 
Enterprise Manager products, including packs, to Release 2.1 on all 
machines where the software will be used, including, but not necessarily 
limited to Management Servers. As soon as the repository has been 
upgraded, all Release 2.0 products will cease to operate against that 
repository, regardless of where they are running.

Note: Before you attempt to upgrade the repository, you must first back 
up the database or schema. If there is a failure during a repository 
upgrade, the repository will no longer be usable. The failed repository no 
longer appears in the list of available repositories that can be upgraded.

Note: Before you attempt to perform an upgrade, you must first stop all 
Management Servers and Oracle Enterprise Manager applications that 
are using this repository. If any Management Server is currently using 
this repository, upgrading the repository causes a server error.
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Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant, the "Configuration 
Operation" page appears. 

Select "Upgrade an existing repository" from the list of configuration operations and 
press Next to continue. The "Select Database for Repository" page appears.

Step 2 "Select Database for Repository"
Log in to the database which contains the repository you want to upgrade. You 
must connect to the database as a user with DBA privileges.

For information about logging in to the database which contains the repository, 
refer to Step 2 "Select Database for Repository" on page 2-6.

If you log in successfully, the "Select Repository" page appears.

Step 3 "Select Repository"
If the Enterprise Manager Configuration Assistant detects that Release 2.0 
repositories exist in the specified database, they are displayed. Choose the 
appropriate repository and press the Next button to continue. 

If the specified database does not contain any Release 2.0 repositories, the list of 
repositories is empty and grayed out, and a note stating that "No repositories were 
found in the database" appears. You may click the Cancel button to exit the 
Enterprise Manager Configuration Assistant or click the Back button to return to 
previous pages to change the information.

Note: The repository schema user created by the Enterprise Manager 
Configuration Assistant will not have the necessary DBA privileges for 
this step. To avoid potential security issues, do not grant more privileges 
to your repository schema user than is necessary. Connect to the 
database as a different user with DBA privileges instead. For example, 
system/manager.
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Step 4 "Repository Login Information"
In the "Repository Login Information" page, you must supply the repository user 
password. 

During repository creation, a database user (repository schema user) who owns the 
repository was created by the Enterprise Manager Configuration Assistant with the 
username and password you have supplied. 

In order to perform a repository upgrade, it is necessary to logon to the repository 
database as this user. 

The repository user name has been entered into the username field as a result of 
your choice in the previous page. However, you will need to enter the password.

Press Next to continue. The "Upgrade Repository Summary" page appears. 

Step 5 "Upgrade Repository Summary"
The "Upgrade Repository Summary" page provides a summary of all the 
information supplied during the upgrade repository wizard. Click Finish to initiate 
repository upgrade or click Back to return to previous pages to change the 
information.

Step 6 "Configuration Assistant Progress"
When you click the Finish button, the Configuration Assistant Progress window 
appears, showing the processing performed and the processing steps that comprise 
the operation being performed. Each processing step is shown by a line of text. 

If you want to see detailed information, click the "Show Details" button to expand 
the dialog to show a text area. You can hide the text area by pressing the "Hide 
Details" button. 

The Cancel button changes to a Close button when processing is completed whether 
it is successful or not.

When all of the steps have been completed without error, the "Processing 
completed." message appears.

You can cancel the requested operation before it completes by clicking the Cancel 
button. 

Click the Close button when you are finished. 
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Drop an Existing Repository
In order to drop a repository, you must connect to the database as a user with DBA 
privileges. 

To drop the repository, follow the steps outlined in the following sections.

For information about starting the Enterprise Manager Configuration Assistant, 
refer to "Starting the Enterprise Manager Configuration Assistant" on page 2-4.

Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant, the "Configuration 
Operation" page appears. 

Select "Drop an existing repository" from the list of configuration operations and 
press Next to continue. The "Select Database for Repository" page appears.

If the Configuration Assistant cannot write to the omsconfig.properties file, 
the "Configuration File Not Accessible" page appears. 

Step 2 "Select Database for Repository"
Log in to the database which contains the repository you want to drop. You must 
connect to the database as a user with DBA privileges.

Note: Before you attempt to drop the repository, you must first stop all 
Management Servers and Oracle Enterprise Manager applications that 
are using this repository. If any Management Server is currently using 
this repository, deleting the repository causes a server error.

Note: The repository schema user created by the Enterprise Manager 
Configuration Assistant will not have the necessary DBA privileges for 
this step. To avoid potential security issues, do not grant more privileges 
to your repository schema user than is necessary. Connect to the 
database as a different user with DBA privileges instead. For example, 
system/manager.
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For information about logging in to the database which contains the repository, 
refer to Step 2 "Select Database for Repository" on page 2-6. If you log in 
successfully, the "Select Repository" page appears.

Step 3 "Select Repository"
If the Enterprise Manager Configuration Assistant detects that Release 2.1 
repositories exist in the specified database, they are displayed. Choose the 
appropriate repository and press the Next button to continue. 

If the specified database does not contain any Release 2.1 repositories, the list of 
repositories is empty and grayed out, and a note stating that "No repositories were 
found in the database" appears. You may click the Cancel button to exit the 
Enterprise Manager Configuration Assistant or click the Back button to return to 
previous pages to change the information.

Step 4 "Select Drop Repository Options"
From the "Select Drop Repository Options" page, you can choose to drop the 
repository user and all its schema objects or merely the repository objects.

If you choose to drop only the repository, you must supply the repository user’s 
password so that the Enterprise Manager Configuration Assistant can connect to 
the repository in order to invoke the Oracle Enterprise Manager Release 2.1 SQL 
drop scripts. Only repository objects are dropped. Other schema objects in the 
repository remain. 

If you choose to drop the repository user and all its schema objects, a password is 
not required. 

If the Configuration Assistant detects that a managed repository is specified in the 
omsconfig.properties file, and you are not dropping that repository, the 
Configuration Assistant will not change the Management Server configuration.

If you are dropping the managed repository, the Configuration Assistant will clear 
the Management Server configuration. 

Note: Make sure that you do not have other objects of value in that 
schema before proceeding with this step. Valuable data may be lost if you 
do not ensure this.
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Press Next to continue. The "Drop Repository Summary" page appears. 

Step 5 "Drop Repository Summary"
The "Drop Repository Summary" page provides a summary of all the information 
supplied during the drop repository wizard. Click Finish to initiate repository 
removal or click Back to return to previous pages to change the information.

Step 6 "Configuration Assistant Progress"
When you click the Finish button, the Configuration Assistant Progress window 
appears, showing the processing performed and the processing steps that comprise 
the operation being performed. Each processing step is shown by a line of text. 

If you want to see detailed information, click the "Show Details" button to expand 
the dialog to show a text area. You can hide the text area by pressing the "Hide 
Details" button. 

The Cancel button changes to a Close button when processing is completed whether 
it is successful or not.

When all of the steps have been completed without error, the "Processing 
completed." message appears.

You can cancel the requested operation before it completes by clicking the Cancel 
button. 

Click the Close button when you are finished.
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Edit Configuration Parameters
Use the Edit Configuration Parameters selection if you want to perform the 
following tasks:

■ set up a Management Server to manage an already existing repository

■ change the Management Server configuration to use another repository

■ change the password that the Management Server uses to log into the 
repository when it starts

■ change the Management Server to use a repository in another database

The Configuration Assistant can only set or change configuration parameters 
(omsconfig.properties file) for the machine on which it is running. It does not 
have the ability to change another machine’s configuration parameters; you must 
go to each of the other Management Servers administering the repository and run 
the Configuration Assistant using the Edit Configuration Parameters option to 
change each machine’s configuration parameters.

You must set up or change the repository connect information (user name, 
password, service) to point to the correct repository. It is important that all the 
Management Server machines that are administering the same repository have 
consistent configuration parameters.

To edit the Management Server configuration parameters, follow the steps outlined 
in the following sections.

For information about starting the Enterprise Manager Configuration Assistant, 
refer to "Starting the Enterprise Manager Configuration Assistant" on page 2-4.

Note: The Enterprise Manager Configuration Assistant will only set or 
change configuration parameters for the machine that it is running on.

Note: If you change the password for the database user account which 
owns the repository, you must also change the corresponding 
Management Server configuration parameter for every Management 
Server that uses the repository; otherwise, the next Management Server 
start will fail.
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Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant, the "Configuration 
Operation" page appears. 

Select "Edit Configuration Parameters" from the list of configuration operations and 
press Next to Continue. The "Configuration Parameters" page appears.

Step 2 "Configuration Parameters"
Set up or change the parameter you want. This information will be used when this 
machine’s Management Server next initializes. If any of the information is invalid, 
then the Management Server will not start successfully.

User Name 
Enter the repository’s user name to change the Management Server configuration to 
use another repository. The user name is a database username, not an Oracle 
Enterprise Manager administrator name.

Password 
Enter the repository user’s password to change the password that the Management 
Server uses to log into the repository when it starts. 

If you change the password, you must also change the Confirm field so that it 
matches the password you changed.

Service
Enter the service/database where the repository resides to change the Management 
Server to use a repository in another database.

Note: In order to progress to the next page, you must change at least 
one of the parameters in this page. If the Next button is pressed without 
changing anything, an error message appears: "There were no changes to 
the configuration parameters. Make changes or cancel." In this case, the 
Enterprise Manager Configuration Assistant does not allow navigation 
to the next page.
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Step 3 "Modify Configuration Parameters"
The "Modify Configuration Parameters" page provides a summary of all the 
information supplied during the modify Management Server parameters wizard 
operation. Click Finish to initiate the change or click Back to return to previous 
pages to change your information.

Configuration File Not Accessible
The "Configuration File Not Accessible" page appears when you have chosen to 
create or drop a repository and the omsconfig.properties file was not 
accessible. The omsconfig.properties file may not be accessible because write 
permissions are not available on the file. 

You can continue to perform the repository operation without modifying the 
omsconfig.properties file or you may choose not to continue with the 
operation. 

If you select "Perform the repository operation anyway," the Next button is enabled 
and you are allowed to continue with the normal sequence of creating or dropping 
a repository. However, in this case, the omsconfig.properties file will not be 
modified.

If you are performing a repository creation, the Configuration Assistant creates the 
repository, but not the omsconfig.properties file. You will not be able to start 
the Management Server until you have write access to the file.

The summary page will indicate that the configuration file will not be updated, and 
"Set Configuration Parameters" will not appear as a processing step in the 
Configuration Assistant Progress window." 

Later, when you have gained write access to the omsconfig.properties file, you can 
use the "Edit Configuration Parameters" option to enter the database username, 
password and service information for the repository that the Management Server 
will use. Once the configuration file has been updated, you will be able to start the 
Management Server.

If you select "Do not perform the repository operation," the "Configuration File Not 
Accessible" page becomes the last page. The Next button is disabled. No changes 
are performed. In this case, you can either go back to the previous page, or cancel.
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                                                            Troublesho
C

Troubleshooting

Please check the compatibility matrix in the Oracle Enterprise Manager Readme 
before installing or using Oracle Enterprise Manager. emreadme.wri or 
emreadme.html is located in the ORACLE_HOME\RelNotes\EM directory. For 
example, C:\Oracle\Ora81\RelNotes\EM.

This chapter describes possible troubleshooting issues. 

■ Reporting Problems to Oracle Support

■ Setting Up Logging and Tracing

■ Troubleshooting the Management Server

■ Troubleshooting the Paging Service

■ Troubleshooting the Web Browser

■ Resetting the Password

■ Troubleshooting the Enterprise Manager Configuration Assistant

■ Changing the Permissions on the omsconfig.properties File

■ Determining the SGA Size

■ Troubleshooting Job Notifications
oting C-1



Reporting Problems to Oracle Support
Reporting Problems to Oracle Support
When you use Oracle Enterprise Manager and encounter problems, you can turn to 
many sources for help.

Before you contact Oracle Technical Support, please take the time to consult your 
manuals and the Oracle Enterprise Manager Readme. A list of Oracle Enterprise 
Manager manuals are listed in the Preface under Documentation Set on page xii.

Manuals
Manuals of particular interest are listed below:

■ The Oracle Enterprise Manager Readme Release 2.1 provides important notes on 
updates to the software and other late-breaking news, as well as any differences 
between the product’s behavior and how it is documented.

■ The Oracle Intelligent Agent Users Guide describes how to administer the Oracle 
Intelligent Agent and provides troubleshooting information.

■ The Oracle Enterprise Manager Messages Manual Release 2.1 contains probable 
causes and recommended actions for Oracle Enterprise Manager errors.

MetaLink
In addition to the manuals and online help, Oracle offers OracleMetaLink, an 
electronic support service available to Oraclemetals (Gold, Silver, Bronze) 
customers, 24 hours a day, seven days a week. Customers can register on-line 
through http://www.oracle.com/support. 

MetaLink 2.0 includes the following features: 

■ My Headlines

Uses push technology to provide you with proactive notifications. My Headlines 
gives you the ability to customize information in your user profile such that you 
get only the specific information you desire when you access the My Headlines 
section of MetaLink. You can also choose to have this information sent to you 
via email. The information delivered to you falls into the following categories 
and can be personalized by product and platform: News & Notes, Knowledge 
Base, Patches, Bugs, TAR Updates, Product Lifecycle, and Forum Updates. 
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■ User Administration

Gives companies the ability to manage access of MetaLink users at the support 
identifier/CSI level. In situations where you want to restrict the access to 
certain areas of MetaLink to specific users at your site, this feature enables that 
control. For example, only internal help desk employees at your site may be 
allowed to create TARs in MetaLink. 

■ User Profile

You can update your contact information, add and remove support identifiers, 
see other users registered under the same support identifier, customize 
MetaLink, change your password, and view your license information. You will 
now have a choice of languages in which to view the MetaLink interface: 
English, German, or French. 

■ Technical Libraries

Organized by product and platform, these libraries enable you to access 
information that support analysts have determined will aid you in your 
installation and use of Oracle products (documentation, white papers, 
problem/solution articles, and more). 

■ Forums

You can post questions to technical analysts and receive responses within two 
business days. Users also share information and ideas with other Oracle users. 

■ File Access

Previously referred to as Download, this section provides you the ability to 
download patches and patch sets directly from within MetaLink. View the 
Readme files to find out which bugs have been fixed in the patch sets. 

■ Knowledge Base Search

Allows you to do a full-text search against the internal repositories within 
Oracle Support Services. Advanced searching is also available. 

■ Bug Search

Provides you with query access to published header and abstract information in 
the Oracle Bug Database. 
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Oracle Technical Support
If the manuals and MetaLink do not answer your questions, contact Oracle 
Technical Support and provide them with the following information:

1. What is the problem?

2. What were you doing when the problem occurred?

■ In which product or component is the problem occurring?

■ What operations were you performing? Is the problem reproducible? What 
are the steps you took to see the problem?

3. What is your environment?

■ What is your operating system and version?

■ What version of Oracle Enterprise Manager are you using and where is it 
installed?

■ What version of the Intelligent Agent are you using and where is it 
installed?

■ What version of the database are you using and where is it installed?

■ Where is the Management Server installed?

■ What version of the Data Collection Service are you using and where is it 
installed?

■ Provide schema, data, scripts, or any other relevant information about your 
environment. If possible, provide log files to assist in problem reproduction. 

4. What error messages and numbers did you see?

5. Turn on tracing (when available) and provide tracing information.

6. Look at log files (when available) and provide log information.
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Setting Up Logging and Tracing
The Oracle Enterprise Manager Release 2.1 system supports tracing and logging. 
Tracing is the writing of data to a display for informational purposes. Logging is the 
redirection of trace information to a file.

This appendix discusses the following topics:

■ Tracing and Logging for the Management Server

■ Tracing for the Client

■ Tracing for the Web Browser

■ Tracing for Paging

Tracing and Logging for the Management Server
Logging and tracing of the Management Server is specified in the 
omsconfig.properties file, located in the $ORACLE_HOME\sysman\config 
directory.

Logging and Tracing Properties
The logging and tracing properties are listed below: 

TRACING.ENABLED = <true>|<false>
Activates/deactivates tracing. Default is false.

LOGGING.ENABLED = <true>|<false>
Activates/deactivates logging. Default is false.

LOGGING.DIR = <directory_spec>
Default is $ORACLE_HOME\sysman\log.

 

Note: In order to set LOGGING.DIR to a directory of c:\temp, you 
must use "\\" and set LOGGING.DIR=c:\\temp 

If you do not, the \t in c:\temp is read as a tab character and the 
Management Server fails to start.
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TRACING.LEVEL = <oem_trace_levels> 
Set value to specify the detail of trace information to collect if tracing is enabled. 

Possible values for <oem_trace_levels> are listed below:

■ 5 - user: displays only messages of a critical or error level.

■ 3 - admin: displays user trace level messages and warning messages.

■ 2 - dev: displays all messages from admin trace level as well as informational 
and debug message

LOGGING.FILENAME = <filename>
Defaults to oms.log.0, oms.log.1, oms.log.2, and so on.

LOGGING.MAX_SIZE = <integer>
Controls the total maximum size of the log files. The value you specify for the 
OEM.LOGGING.MAX_SIZE property is in MB. Its default value is 50 and will result 
in two log files of max size 25MB. Setting the parameter to 0 indicates that a single 
log file will be used with no limit.

LOGGING.MAX_FILE_CNT = <integer>
Defines the maximum number of files the log will span at any given time. The 
cumulative size of all the files would be less than or equal to LOGGING.MAXSIZE.

Default value is 2.

Note: If LOGGING.MAX_SIZE=0 (unlimited log size), LOGGING.MAX_FILE_CNT 
will not make sense and hence ignored.

LOGGING.SAVE_PREVIOUS_LOG = <true>|<false>
A true value indicates that the Management Server is to rename any existing log 
files from a previous Management Server invocation. Such log files would be 
appended with a timestamp (format: yyyyMMddHHmmss) when they are renamed.

Default value is false.

 

Note: Logging and tracing of the Backup and Data Management is also 
specified in the omsconfig.properties file:

OEM.TRACING.ENABLED = TRUE

OEM.TRACING.LEVEL = 2
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Management Server Logs
The Management Server places all its trace messages in Management Server log 
files (oms.log.0, oms.log.1, oms.log.2, and so on). It writes to one log file, 
and when the log file is full, it writes to the next file, recycling the last two files.

The Management Server’s log files have size limits. By default, when the 
Management Server starts, it can only create log files with a size of 25 MB. The 
initial log file name is oms.log.0. If the file reaches its 25 MB limit, a separate log file 
is created. The separate log file name is oms.log.1. If that file reaches its 25 MB 
limit, the oms.log.0 file is deleted and a new log file, oms.log.2, is created. The 
last two log files are kept.

 

Important Note: When the Management Server starts, all previous log 
files of the name oms.log.* are automatically deleted. 
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Tracing for the Client
To activate client tracing of all client applications integrated with Enterprise 
Manager, add and save the following parameters and values for the 
clientconfig.properties file, located in the 
$ORACLE_HOME\sysman\config directory. 

OEM.TRACING.ENABLED=TRUE 
OEM.TRACING_LEVEL=2 
 

In addition, for Windows NT only, open a DOS window and set the following 
environment variable: 

C:\>SET ORACLE_OEM_CLIENTTRACE=TRUE

Then start a client application via the OEMAPP script. You cannot perform logging 
tracing of the client application on STDOUT. In other words, you cannot start the 
applications using icons or shortcuts if you want to trace them, and redirect the 
output to a file. 
C-8 Oracle Enterprise Manager Configuration Guide                             



Setting Up Logging and Tracing
Tracing for the Web Browser 
If you encounter problems bringing up Oracle Enterprise Manager in a browser, 
collect tracing information before reporting the problem to Oracle Support Services. 

To set up tracing for your browser perform the following steps: 

1. Exit your browser session 

2. Start the java plug-in Console. 

From the Windows Start menu, click Programs->Oracle JInitiator Control Panel 
1.1.7+. A window appears. Click the "Show Java Console" checkbox and click 
Apply. Close the plug-in properties window. 

3. Restart your browser and reload Oracle Enterprise Manager. 

The java console window appears, showing the java classes loaded by the 
plugin as well as any exceptions that may occur. If no exceptions are displayed, 
clear the screen (by clicking the Clear button) every 3rd or 4th screen-full of 
displayed information. 

4. If an exception appears in the java console window, please cut and paste it into 
a file and send it to Oracle Support Services along with a description of your 
problem. 
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Tracing for Paging
The paging service can be debugged and traced separately from the Management 
Server. If tracing is enabled, the server writes trace statements for all telephone line 
handling and any success or failure. 

In the paging.cfg file, the following parameters influence the tracing:

TRACING.ENABLED
Set value for debugging purposes; paging service will then track what paging is 
occurring by writing trace statements for all telephone line handling and any 
successes or failures. 

The value can be either TRUE or FALSE. If the value is set to TRUE, you must 
specify a value for TRACEFILENAME and a value for TRACING.LEVEL. If the value 
is set to FALSE, you need not specify values for TRACEFILENAME and 
TRACING.LEVEL.

TRACING.LEVEL
Set value to specify the detail of trace information to collect if tracing is enabled. 

Possible values are listed below: 

■ 5 - user level: collects critical messages and error messages

■ 3- admin level: collects critical, error, and warning messages

■ 2 - dev: collects maximum trace information

TRACEFILENAME
Set value for where to write tracing output if tracing is enabled. 

Oracle recommends setting the value to PAGING_LOG.TRC. 

By default, this file is located in the Intelligent Agent’s 
ORACLE_HOME\SYSMAN\LOG directory.
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Troubleshooting the Management Server
This section contains the following topics:

■ Management Server May Not Run Correctly from a Non-Default Oracle Home

■ Management Server Does Not Start from the Windows NT Start Menu

■ Changing Your Management Server for Client Access

■ Setting the Ping Interval

Management Server May Not Run Correctly from a Non-Default Oracle Home
On Unix, if the ORACLE_HOME environment variable is not set to the Oracle home 
where the management server is running, the management server will not start 
correctly. It will try to find its class files in the default Oracle home instead of the 
correct Oracle home.

csh
To set the environment variable:

setenv ORACLE_HOME ’/usr/local/oracle’

ksh/sh
To set the environment variable:

ORACLE_HOME = ’/usr/local/oracle’
export ORACLE_HOME

On UNIX systems, the Oracle environment can also be set by calling coraenv (for 
the CSH) or oraenv (for any other shell). This shell script sets the oracle 
environment for a given identifier. This identifier can be a specific database or it can 
point to an ORACLE_HOME which contains the Management Server software. These 
scripts can be customized to include specific machine or server based settings. 

Refer to the specific operating system’s Oracle Administration documentation for 
more information about the coraenv and oraenv scripts. 
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Management Server Does Not Start from the Windows NT Start Menu
If you are starting the Management Server from the Windows NT Start menu and if 
you have chosen not to store your repository credentials during repository creation, 
you must enter the repository’s user name that was used to create the database user 
and the password for that user in the Service Startup dialog box when you start the 
Management Server. 

You Did Not Enter the Repository Credentials in the Service Dialog
If you do not supply the repository’s user name and the password in the Service 
dialog, the Management Server logs a message in the Windows NT Event Log. See 
Accessing the Windows NT Event Log for more information.

Consequently, the Management Server will not start.

You Enter the Wrong Credentials in the Service Dialog
If you enter the wrong credentials, the Management Server will not start. 

The Management Server log file will contain an error. The Management Server log 
file, oms.log, is located in the $ORACLE_HOME\sysman\log directory. Check the 
output to determine the problem. The message will probably say, "invalid login." 

No error message will appear on screen; the information is logged in the Windows 
NT Event Log instead. See Accessing the Windows NT Event Log for more 
information.

You must restart the Management Server and reenter the correct credentials in the 
Service dialog for the Management Server to start.

Accessing the Windows NT Event Log
To access the Windows NT Event Log to view the events logged by the 
Management Server. 

1. From the Start menu->Programs->Administrative Tools (Common), select the 
Event Viewer item.

2. Select Application from the Log menu.

3. When the log screen appears, double-click any event logged by the 
Oracle<Oracle_Home_Name>ManagementServer service which have red 
octagonal stop signs next to them. These will be the errors reported by the 
Management Server, if any. 
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Changing Your Management Server for Client Access
If a Management Server fails in a multi-Management Server environment, it only 
affects the clients connected to it. Each Management Server is independent of the 
other Management Servers connected to the repository.

To change your Management Server node to another node where a Management 
Server is still running, follow the procedure below. 

1. In the Oracle Enterprise Manager login, select a node that has a Management 
Server which is configured with the repository you want to access from the 
Management Server pull-down list. 

If the node name where the Management Server is running does not appear in 
the pull-down list, follow the instructions below: 

a. Click the Management Servers button. The Management Servers dialog 
appears. 

b. Click the Add button. The Add Management Server dialog appears. 

c. Type in the name of the node where the Oracle Management Server is 
running that is configured with the repository you want to access and click 
OK. 

d. Select the node where the Oracle Management Server is running from the 
pull-down list.

2. On each machine which runs Oracle Enterprise Manager through a web 
browser, return to the EmWebSite.html page to change the machine name to 
point to the node where a management server is running. You cannot simply 
enter a new Management Server machine name at the Oracle Enterprise 
Manager Login screen.
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Setting the Ping Interval
In Release 2.1, the Management Server is designed to ping all targets on a 
pre-defined interval to monitor the state of all managed targets.

To manage the interval between pings, you can use the following property in the 
omsconfig.properties file to set the ping interval:

oms.vdp.ping_interval=<integer; time in minutes>

Note that the interval set determines the interval at which the Management Server 
tests for node up/down, regardless of what you set in the event which contains a 
node up/down test.
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Troubleshooting the Paging Service

Paging Does Not Work
If you have followed the instructions for configuring your paging service and it still 
does not work, check the following:

■ Do all required properties of the PAGING.CFG file contain values? See 
Table 6–1, "Paging Configuration Properties" for more information. 

■ After configuring your paging service, did you restart the Intelligent Agent? 

■ Are there multiple entries of the following in the NMICONF.LST file located in 
the Intelligent Agent's ORACLE_HOME\Network\Agent\Config\ directory? 
Only one entry should exist. If there are duplicates of this entry, remove all but 
one: 

<drive letter>:\<the Intelligent Agent’s 
ORACLE_HOME>\network\agent\config\NMIPAGING.TCL 

For example, if the Intelligent Agent is installed on F:\Oracle\Ora81, you 
should see only one entry for the following:

F:\Oracle\Ora81\network\agent\config\NMIPAGING.TCL 

Registering the Paging Service with a Remote Oracle Management Server 
By default paging services are configured to register with a local Management 
Server using boot port 7771. 

However, you must edit the PAGING.CFG file so that the service registers with the 
remote Management Server and/or registers with the Management Server on a 
different boot port if the Management Server is: 

■ remote, 

■ configured to use a boot port other than the default, or 

■ remote and configured to use a different boot port. 

You must add the following properties to the PAGING.CFG file located in the 
Intelligent Agent's ORACLE_HOME/sysman/config directory: 

OEM.MANAGEMENT_SERVER=<oms-hostname> 
OEM.MANAGEMENT_SERVER.BOOTPORT=<integer> 

Replace <oms-hostname> with the hostname of the remote Oracle Management 
Server and <integer> with the boot port the Management Server is using. 
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Modifying the Paging Service Information from the Enterprise Manager Console 
From the Enterprise Manager Console, you may modify dialing information for 
your paging service (i.e. country code, area code, phone number and suffix.). You 
can edit these properties by following the instructions below: 

1. Go to the Navigator pane of the Console. 

2. Open the Paging Services folder. 

3. Right mouse-click on the appropriate paging carrier.

4. Select Edit and the Edit Paging Carrier dialog box appears. 

Page Notification Fails 
If a page notification fails, the paging service will try to resend the page three more 
times. The interval of time between these retries is a value that can be altered. By 
default, the interval of time between retries is 1 minute. You can change this default 
setting by editing the OMSCONFIG.PROPERTIES file located in the Management 
Server’s ORACLE_HOME\sysman\config directory. Users can add the property 

OEM.PAGING.RETRYINTERVAL=<integer> 

to the OMSCONFIG.PROPERTIES file and replace <integer> with the number of 
minutes between retries. 

Troubleshooting the Web Browser
If you start the web browser, log in to the Console, but the Console hangs, and the 
following is displayed in JInitiator Console:

The Console hangs after you start the web browser and log into the Console. The 
following message is displayed in the JInitiator Console:

@org.omg.CORBA.INITIALIZE[completed=MAYBE, reason=java.net.BindException: 
Cannot assign requested address]

You must perform the following steps:

1. Check that JInitiator uses browser settings for the proxy.

2. Append the domain name to webserver address you type in the browser, e.g. 
@.us.oracle.com

3. Edit the browser settings and add that domain to "no proxy settings for" or edit 
the browser settings and choose Direct Connection to Internet.
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Resetting the Password
If you forget your SYSMAN password and need to reset it to oem_temp, follow the 
instructions below:

You must first be connected to the Management Server repository (via SQL*Plus) 
before using the reset_sysman() procedure.

1. Start SQL*Plus from the command line by typing:

sqlplus

2. When you are prompted for the connection information, type:

<emrepository>/<emrepository-pwd>@<em-repository> 

to connect to the database.

For example: 

mynode/mypassword@mynode.world

since the default repository name is the hostname.

3. Then type: 

execute smp_maintenance.reset_sysman(); 
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Troubleshooting the Enterprise Manager Configuration Assistant

Enterprise Manager Configuration Assistant Errors 
This section describes the Enterprise Manager Configuration Assistant error 
messages and their probable causes, and provides the actions recommended to 
correct them.

omsconfig.properties file is not accessible
If the omsconfig.properties file is not writable, the "Configuration File Not 
Accessible" page appears. Please refer to Configuration File Not Accessible on page 
B-10 for more information. 

The Database User You Chose Does Not Have the Necessary DBA Privileges
When you login as a DBA user on a selected database, the Configuration Assistant 
checks whether the user has the necessary privileges. If the user does not have the 
necessary DBA privileges, a message appears: "The database user you chose does 
not have the necessary DBA privileges. Logon to the database as a user with DBA 
privileges." Click OK to dismiss the message box. You must enter the proper 
credentials in order to continue. Enter the credentials and try again.

Select Database for Repository Login is Unsuccessful
If you have entered an invalid username, password, or service, an error message 
indicating the failure appears. For example: "Connection failed ORA-01017: Invalid 
username/password; logon denied" message appears. Click OK to dismiss the 
message box. Enter the data and try again.

The User Already Exists
The user already exists, and already contains an incomplete Enterprise 
Management Release 2 repository. A repository create, drop, or upgrade operation 
may be in progress, or a previous operation may have failed. Continuing the current 
operation can replace incomplete components and create missing components in the 
repository. 

What would you like to do? 

■ Select another user. 

■ Continue and use the selected repository. 

If a repository operation is already actively in progress elsewhere, do not continue. 
Attempting to perform simultaneous operations on the same repository may cause 
repository corruption. 
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The user "<username>" already contains a complete and up-to-date Enterprise 
Manager V2 repository
The user "<username>" already contains a complete and up-to-date Enterprise 
Manager Release 2 repository. If you wish to overwrite the existing repository, first 
use the Drop option. 

The User Already Exists and Contains a V1 Repository
If the Oracle Enterprise Manager Configuration Assistant detects that the chosen 
repository name is the name of an already existing user/schema in the database and 
that it contains an Oracle Enterprise Manager Release 1.x repository, a message 
appears: “The user already exists and contains a V1 repository. A V2 repository may 
not coexist with a V1 repository in the same schema. Please choose another user 
name.”

The User Already Exists in this Database
If the Oracle Enterprise Manager Configuration Assistant detects that the chosen 
repository name is the name of an already existing user/schema in the database, 
and that it contains neither an Oracle Enterprise Manager Release 2.1 nor Release 
1.x repository, a message appears: "The user already exists in this database. Do you 
wish to create the repository within this user’s schema anyway?" 

If you choose no, you may select a different user name. 

If you choose yes, the "Create Repository Summary" page appears. Refer to Step 5 
"Create Repository Summary" on page 2-14 for more information.

The Management Server on this Machine is Currently Managing a Repository 
Owned by user <user_name> on service <service_name>
During create repository, if the Configuration Assistant detects that a managed 
repository is already specified in the omsconfig.properties file, and you are 
creating a repository that is different from the managed repository, a message 
appears: "The Management Server on this machine is currently managing a 
repository owned by user <user_name> on service <service_name>. Would you like 
to change it to now manage the repository owned by user <user_name> on service 
<service_name>?" 

If you choose yes, the configuration will be updated. The Management Server must 
be stopped and restarted in order for the changes to the configuration file to take 
effect. If you choose no, the configuration will not be updated. The “Create 
Repository Summary” page and the steps in the Configuration Assistant Progress 
Window will reflect your choices. 
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You have chosen the user’s default or temporary tablespace to be SYSTEM.
Note that the Configuration Assistant, when it creates the user for an Oracle 
Enterprise Manager repository, asks you for the default and temporary tablespaces 
to use. If you choose SYSTEM for either of these, Configuration Assistant puts up 
the following warning: "You have chosen the user’s default or temporary tablespace 
to be SYSTEM. We recommend the SYSTEM tablespace be used only for data 
dictionary tables and the SYSTEM rollback segment. Are you sure?" Pick another 
tablespace. 

The Default Tablespace for the Repository Does Not Contain Enough Free Space
If the Oracle Enterprise Manager Configuration Assistant detects that the default 
tablespace for the repository does not contain enough free space, the following 
message appears: "The default tablespace for the repository does not contain 
enough free space." Refer to Repository Database Default Tablespace Does Not 
Contain Enough Free Space on page C-21 for information for possible solutions.
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Repository Database Default Tablespace Does Not Contain Enough Free Space
The Configuration Assistant checks that the selected default tablespace for the 
repository has the appropriate attributes/characteristics, but if it does not contain 
enough free space, the following message appears: "The default tablespace for the 
repository does not contain enough free space."

For 8.1.x, use the OEM_REPOSITORY tablespace if it exists. It is the default 
tablespace for Enterprise Manager. 

If you are creating a repository in a new user, the Configuration Assistant’s Select 
Repository User Tablespaces screen strongly encourages you to create an 
OEM_REPOSITORY tablespace. Using the Enterprise Configuration Assistant to 
create the OEM_REPOSITORY tablespace ensures that the tablespace has 
appropriate attributes/characteristics.

However, if you prefer, you can create another tablespace or increase the size of an 
existing tablespace. 

Refer to Appendix D, "Repository Sizing" to determine storage requirements and 
disk space allocation for your Oracle Enterprise Manager repository.

Creating an OEM_REPOSITORY Tablespace if One Does Not Exist
If the OEM_REPOSITORY tablespace has not been created for you, the "Create a new 
OEM_REPOSITORY tablespace (recommended)" option is available on the "Select 
Repository User Tablespaces" page of the Enterprise Manager Configuration 
Assistant.

Select this option if you want to create the OEM_REPOSITORY tablespace. Using 
the Enterprise Manager Configuration Assistant to create the OEM_REPOSITORY 
tablespace gives that tablespace appropriate attributes/characteristics. Then use it 
as the user's default tablespace. 

Note: You do not have to exit from the Configuration Assistant when 
using DBA Studio’s Storage Management to create another tablespace or 
increase the size of an existing tablespace.
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Creating Another Tablespace
To use DBA Studio’s Storage Management to create a new tablespace, follow the 
procedure described in this section:

1. Start the DBA Studio in standalone mode.

■ On Windows NT:

You can start the DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> DBA Management 
Pack->DBA Studio.

■ On UNIX:

You can start the DBA Studio from the command line using the command:

oemapp dbastudio

When the login dialog appears, choose Connect directly to databases and press 
OK. 

2. Double-click the database icon in the DBA Studio navigator tree and connect to 
the database as a user with the SYSDBA privilege.

3. Select Create from the Object menu, then Tablespace, and click Create. The 
Create Tablespace property sheet appears.

4. In the Create Tablespace Property Sheet’s General page, enter the name of the 
new tablespace and specify that the tablespace will be used to hold permanent 
database objects.

5. In the Datafile section, enter the size of the new datafile. The File Name and File 
Directory columns should already contain default entries. 

6. Right-click the "+" sign which appears next to the name of the datafile 
(<name>.ora) and choose Edit, double-click the datafile row, or choose the Edit 
button (pencil icon). The Create Datafile property sheet appears.

7. In the Create Datafile’s Storage page, select the "Automatically extend datafile 
when full (AUTOEXTEND)" box so that the datafile will automatically increase 
in size when more space is needed in the database. 

8. Click the OK button in the Create Datafile property sheet.

9. In the Create Tablespace Property Sheet’s Storage page, choose a method of 
space management. You cannot alter the method at a later time. 

10. Click the Create button in the Create Tablespace Property Sheet.
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Increasing the Size of an Existing Tablespace
To use DBA Studio’s Storage Management to increase the size of an existing 
tablespace, follow the procedure described in this section:

1. Start the DBA Studio in standalone mode.

■ On Windows NT:

You can start the DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> DBA Management 
Pack->DBA Studio.

■ On UNIX:

You can start the DBA Studio from the command line using the command:

oemapp dbastudio

When the login dialog appears, choose Connect directly to databases and press 
OK. 

2. Double-click the database icon in the DBA Studio navigator tree and connect to 
the database as a user with the SYSDBA privilege.

3. Expand the Storage Management node.

4. Double-click the datafile you want to increase from the Datafiles folder. The 
General page of the Datafile property sheet appears, allowing you to edit the 
file size of the datafile. 

5. Click the Apply button in the General page.

6. Click on the Storage tab. The Storage page of the Datafile property sheet 
appears.

7. Check the "Automatically extend datafile when full (AUTOEXTEND)" box and 
click the Apply button.
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Database Parameters Not Large Enough for Repository Operation
An Oracle Management Server will open a number of repository database sessions 
while processing work on behalf of clients and managed nodes. 

The number of sessions required by a single Management Server generally ranges 
from 5 to 3, depending on the load placed on the Management Server. More 
repository database sessions may be required under the following circumstances: 

■ many Consoles are actively submitting jobs/registering events 

■ multiple Management Servers are concurrently using the same repository 

■ many Intelligent Agents are sending notifications back to the Management 
Servers

If other applications are accessing the same database used for the Enterprise 
Manager Repository this will increase the session load on the database and should 
be considered when setting up the database. 

If your processes setting is too low for Oracle Enterprise Manager, you will receive 
an error message similar to the following in the oms.log file located in the 
Oracle_OEM_Home/sysman/log directory.

can’t open a session

For large workloads, or for cases where multiple applications are accessing the 
database where the repository resides, you can increase the processes parameter in 
the database init.ora to accommodate the workload. 

To use Instance Management to change your database parameters, follow the 
procedure described in this section:

1. Start the DBA Studio in standalone mode.

■ On Windows NT:

You can start the DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> DBA Management 
Pack->DBA Studio.

■ On UNIX:

You can start the DBA Studio from the command line using the command:

oemapp dbastudio

When the login dialog appears, choose Connect directly to databases, and press 
OK. 
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2. Double-click the database icon in the DBA Studio navigator tree and connect to 
the database as a user with the SYSDBA privilege.

3. Expand the Instance Management node.

4. Click the All Initialization Parameters button in the Database Property Sheet’s 
General page. 

5. Change the value of the parameter.

6. Click Save As button on the All Initialization Parameters page. The Save 
Initialization Parameters dialog appears.

7. Enter the complete directory path and a file name or use the Browse button to 
find a location on your local operating system to place the file and enter the file 
name.

8. Press OK to save the file.
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Changing the Permissions on the omsconfig.properties File
If you have chosen to store your repository credentials in the 
omsconfig.properties file during repository creation, you may want to change 
the permissions on the file to restrict who can view it. 

If you change the file permissions, other users cannot view the file. 

UNIX:
To change the file permissions, at the command prompt, enter:

$ chmod 600 omsconfig.properties 

This command sets the read and write permissions only for the owner of the file.

Windows NT:
To change the file permissions, perform the following steps.

1. From the Start menu->Programs, select the Windows NT Explorer item.

2. From Oracle_Home/sysman/config directory, select the 
omsconfig.properties file.

3. Right-click the selected file, and then choose the Properties item in the resulting 
pop-up menu.

4. Select the Security tab from the Properties dialog. Note: This step only applies 
to NTFS file systems.

5. Press the Permissions push-button on the Security page to display the File 
Permissions dialog. The default is "Everyone" has Full Control (All). The type of 
Access is Full Control. 

6. Click the Remove button to remove this entry. 

7. Click the Add button to display the Add Users and Groups window. 

8. Click the Show Users button to view all users. 

Note: The repository credentials stored in the 
omsconfig.properties file do not expose plain text passwords. The 
password, if present, is encrypted in that file.
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9. Select the user who starts the Management Server regularly and uses the 
Enterprise Manager Configuration Assistant for the "type of access" field and 
select "select full control" from the drop down list. 

10. Click the OK button to dismiss the Add Users and Groups dialog. 

11. Click the OK button to dismiss the File Permissions dialog.

12. Click the OK button to dismiss the file Properties dialog.

You can provide access to multiple usernames.
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Determining the SGA Size
The two primary factors in determining SGA size are: 

■ amount of RAM available to the instance, and 

■ the amount of activity you expect on the instance. 

The amount of RAM available to the instance is memory dedicated to the 
repository’s instance. This must not include memory needed for other instances and 
applications on the repository host node. The amount of activity includes all active 
(submitted) jobs, active (registered) events, hosts monitored, and connected 
administrators. As activity increases, so will the demands on the instance.

If the instance is dedicated to the Management Server repository, the basic 
minimums are listed below:

db_block_size = 2048             # EM is a strict OLTP application

db_block_buffers = 2048           # **May need increase under heavy load**

sort_area_size = 128000           # **May need increase under heavy load**

sort_area_retained_size = 128000  # **May need increase under heavy load**

log_buffer = 64000               # **May need increase under heavy load**

The Management Server repository transactions tend to be short, so rollback space 
usually is not a problem. Watch your redo log size and log_buffer size if a high 
transaction (activity per above) rate is expected.
C-28 Oracle Enterprise Manager Configuration Guide                             



Troubleshooting Job Notifications
Troubleshooting Job Notifications
Problem
The job notifications are not being delivered and the console status remains in 
scheduled. Sometimes the jobs work and sometimes the jobs fail. Resubmitting one 
of the jobs results in a "job already submitted" error.

Solution
The agent may be delivering job status/output for the job to two different Consoles 
operating at different IP addresses. 

Another Enterprise Manager installation is probably running on another node with 
the same repository name as the first node. Some job notifications are delivered to 
the first node and some notifications to the second node, depending on which 
machine last registered itself. You must check what is running on the nodes and 
decide which one is your Management Server. 
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                                                           Repository Si
D

Repository Sizing

This appendix provides guidelines for determining storage requirements and disk 
space allocation for your Oracle Enterprise Manager repository. Space requirements 
can vary greatly as a result of what Oracle Enterprise Manager tools you are 
licensed to use and the amount of data generated by the work you perform. In 
addition, the growth of the repository could vary slightly depending upon the 
database version (release 8.1.6 versus release 8.0.6, etc.) in which the repository is 
created. 

If you choose to create a new repository from a typical installation session and 
accept the default configuration for that new repository; then, a new tablespace is 
generated labeled OEM_REPOSITORY. The OEM_REPOSITORY tablespace 
contains repository objects for the Oracle Enterprise Manager Console, DBA 
Management Pack and all separately licensable Packs regardless if you have 
installed or purchased licenses for them. In addition, depending on the database 
version in which the repository is created, the repository could initially allocate 
between 6 - 26 MB of hard disk space.

Depending on how you actually use Oracle Enterprise Manager products, the 
repository size may increase. To determine by how much your repository could 
grow, refer to the table below. To accommodate an increase in repository size, the 
default OEM_REPOSITORY tablespace is automatically configured to autoextend. 
For example, if you have created the default OEM_REPOSITORY tablespace which 
allocates 4 MB for using Capacity Planner for a single, small database, but you 
actually plan to use Capacity Planner on a more regular basis - for example, for 
three large databases - then you should expect the size of your repository to 
increase by approximately 16 MB. In such situations, the tablespace would 
autoextend automatically to accommodate the increase. 
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If you choose to create a new repository from a typical installation session and want 
to use an existing tablespace, follow these steps to determine how much disk space 
the repository will use:

1. Review the "Product" column to find the products you are using.

2. Identify those actions you perform with each product in the "If you…" column.

3. Add the corresponding hard disk space requirements for those actions from the 
"then allocate…" column. The total of these requirements is the expected size of 
your repository.

Product If you... Then allocate...

Oracle Enterprise 
Manager Console and 
DBA Management Pack

■ use only the Console 
and DBA Management 
Pack

■ save little (if anything) 
in job history

4 - 9 MB

Oracle Diagnostics Pack ■ collect less than 4 MB 
of Trace Data

■ use Capacity Planner 
for a single, small 
database over a few 
days 

8 MB

■ collect between 4 - 20 
MB of Trace Data

■ use Capacity Planner 
for a single, 
medium-sized database 
over several months

30 MB

■ collect between 20 - 60 
MB of Trace Data

■ use Capacity Planner 
for up to three large 
databases over several 
months

80 MB
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Oracle Tuning Pack save less than:

■ 50 tuned SQL 
statements

■ 5 scoped tuning 
sessions

■ 10 tablespace jobs in job 
history

less than 15 MB

save between:

■ 50 - 150 tuned SQL 
statements

■ 5 - 15 scoped tuning 
sessions

■ 10 - 30 tablespace jobs 
in job history

15 - 45 MB

save more than:

■ 150 tuned SQL 
statements

■ 15 scoped tuning 
sessions

■ 30 tablespace jobs in job 
history

more than 90 MB

Oracle Change 
Management Pack

■ for a schema with 
approximately 500 
objects:

1 baseline, with 2 saved 
versions of baseline

1 saved comparison

1 change plan 
(propagate the schema)

10 MB

Product If you... Then allocate...
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■ for a schema with 
approximately 500 
objects

2 baselines, with 2 
saved versions of 
baseline

2 saved comparisons

■ 5 change plans

25 MB

■ for a schema with 
approximately 500 
objects

5 baselines, with 2 
saved versions of 
baseline

5 saved comparisons, 
with 2 versions each

■ 10 change plans

50 MB

Oracle Management Pack 
for Oracle Applications

■ use Capacity Planner 
for a single, small 
database over a few 
days

4 MB

■ use Capacity Planner 
for a single, 
medium-sized database 
over several months

10 MB

■ use Capacity Planner 
for up to three large 
databases over several 
months

20 MB

Oracle Management Pack 
for SAP R/3

■ use Capacity Planner 
for a single, small 
database over a few 
days

4 MB 

Product If you... Then allocate...
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■ use Capacity Planner 
for a single, 
medium-sized database 
over several months

10 MB

■ use Capacity Planner 
for up to three large 
databases over several 
months

20 MB

Oracle Standard 
Management Pack1

■ for a schema with 
approximately 500 
objects:· 

1 baseline, with 2 saved 
versions of baseline· 

1 saved comparison

10 MB

■ for a schema with 
approximately 500 
objects· 

2 baselines, with 2 
saved versions of 
baseline· 

2 saved comparisons

20 MB 

■ for a schema with 
approximately 500 
objects· 

5 baselines, with 2 
saved versions of 
baseline· 

5 saved comparisons, 
with 2 versions each

40 MB

1 While the other separately licensable Packs are available with Oracle8i Enterprise Edition, the Oracle 
Standard Management Pack is only available with Oracle8i standard edition.

Product If you... Then allocate...
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For example, if you: 

■ use the Console and DBA Management Pack regularly but typically do not save 
large output to the job history (approximately 7 MB)

■ collect approximately 45 MB of Trace Data (approximately 45 MB)

■ use Capacity Planner very little (approximately 4 MB)

■ save approximately 100 tuned SQL statements, 11 scoped tuning sessions and 
25 tablespace jobs in job history (approximately 32 MB)

The total of all these space allocations (7 MB + 45 MB + 4 MB + 32 MB) is 88 MB. 
Thus, you can expect to allocate approximately 88 MB for your repository.

Important: This is only a guideline based upon default configuration of 
the Oracle Enterprise Manager environment; any custom configuration 
done may significantly affect repository sizing requirements. What 
applications you are actually using in the Console and the various Packs; 
how you have configured certain parameters, etc., all will affect how 
much disk space the repository will require. For instance, the default 
sampling frequency for Oracle Diagnostics Pack is five minutes. If you 
reduce the sampling frequency then you will need to allocate more disk 
space. How much you save in the job history will also affect the amount 
of space necessary for the repository. If you have large outputs of 40-50 
MB and you save those in job history, then you should allocate an 
additional 40-50 MB of disk space.
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Configuring the Webserver and Directory

Mapping

If you are installing the Oracle Enterprise Manager Web Site without the Oracle 
Application Server Listener that is packaged with Enterprise Manager by default, 
configure your supported webserver with the instructions below.

■ Apache 1.3.9 on Solaris

■ Oracle Application Server 4.0.8 on Windows NT and Solaris

■ Internet Information Server (IIS) 4.0 on Windows NT
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Apache 1.3.9 on Solaris
Apache 1.3.9 on Solaris
1. Install the Enterprise Manager web site without the Oracle Application Server 

Listener. 

2. Install Apache 1.3.9. Consult your Apache-specific configuration 
documentation for detailed information.

3. Edit the httpd.conf in the Apache home -> conf ->httpd.conf/. Stop and 
restart the web listener.

4. ScriptAlias controls which directories contain server scripts. ScriptAliases are 
essentially the same as Aliases, except that documents in the realname directory 
are treated as applications and run by the server when requested rather than as 
documents sent to the client. 

The same rules about trailing "/" apply to ScriptAlias directives as to Alias. 

ScriptAlias /oem_webstage/cgi-bin
"/private/oemv2/oem_webstage/cgi-bin"

5. Add as many aliases as you need (with no limit). The format is 

Alias fakename realname

Note that if you include a trailing "/" on fakename, then the server requires that 
it is present in the URL. In this example, "/icons" is not aliased.  "/icons/" is 
aliased. 

Alias /icons/ "/usr/local/apache/icons/" 
Alias /oem_webstage "/private/oemv2/oem_webstage/" 

6. Change "/apache/cgi-bin" to where your ScriptAliased CGI directory exists, if 
you have that configured. 

<Directory "usr/local/apache/cgi-bin"> to

<Directory "/oem_webstage/cgi-bin">

AllowOverride all 
Allow from all 
</Directory> 

AddHandler allows you to map certain file extensions to "handlers", actions 
unrelated to filetype. These can be either built into the server or added with the 
Action command. 
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Oracle Application Server 4.0.8 on Windows NT and Solaris
You must uncomment the following lines to use server side includes or CGI 
outside ScriptAliased directories:

# 
# To use CGI scripts: 
AddHandler cgi-script .exe

Oracle Application Server 4.0.8 on Windows NT and Solaris

1. Install the Enterprise Manager web site without the Oracle Application Server 
Listener. 

2. Install Oracle Application Server 4.0.8. Consult your 
Oracle-Application-Server-specific configuration documentation for detailed 
information.

3. Invoke your web browser and point to the Oracle Application Server V4.0 
administration page at the URL http://<webserver>:<admin-port>/

e.g. http://myserver.mydomain:8888/ 

4. Expand the main section "Website40" site. 

5. In the "HTTP Listener" section, associate the virtual directories to the physical 
directories on the "Directory" page. 

6. After setting up the virtual directories, you must stop and restart the 
corresponding webserver listener.

Note: The steps below do not apply to the Oracle Application Server 
Listener that is packaged with Enterprise Manager by default; they only 
apply to the Oracle Application Server that you install separately from 
Oracle Enterprise Manager.

File-system directory Flag Virtual Directory

<drive>:\oem_webstage\ NR  /oem_webstage/

<drive>:\oem_webstage\cgi-bin\ CR /oem_webstage/cgi-bin/
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Oracle Application Server 4.0.8 on Windows NT and Solaris
Note: If you are using Oracle Application Server 4.0.8, you must use 
Microsoft® Internet Explorer 5.0 or Netscape Navigator® 4.51 or later 
browsers.

If you attempt to use Microsoft® Internet Explorer 4 with Oracle 
Application Server 4.0.8, the following error occurs when launching the 
Console:

exception: Sun.applet.AppletSecurityException: checkpropsaccess.key
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Internet Information Server (IIS) 4.0
1. Install the Enterprise Manager web site without the Oracle Application Server 

Listener. 

2. Install Internet Information Server (IIS) 4.0. Consult your 
Internet-Information-Server-specific configuration documentation for detailed 
information.

3. From the Windows NT Program Start Menu, select Microsoft Internet 
Information Server 4.0->Internet Service Manager to configure the Internet 
Information Server. The "Microsoft Internet Service Manager" screen is 
displayed. 

4. Click on "Default Web Site" and right mouse-click to display the associated 
submenu. 

5. Click on "Properties" to display the Properties sheet of the Default Web Site. 

6. Verify that the IP address of the node is correctly set in the Properties sheet. 
Then click "Ok". 

7. Right-click and choose service properties; then, tab to directories. Click Add.

8. Enter the name of the virtual directory. For example, oem_webstage. 

9. Specify the following settings:

Alias: /oem_webstage

Path: c:/oem_webstage

Access: Read, Execute

10. After saving the settings, expand the "Default Web Site" to display the new 
virtual directory.

11. Select the new oem_webstage virtual directory.

12. Click on the Action button, select New, Virtual Directory to create a additional 
virtual directory with the following settings:

Alias: cgi-bin

Path: c:\oem_webstage\cgi-bin

Access: Read, Execute
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13. Create an additional virtual directory with alias "\oem_webstage\java-plugin" 
and directory c:\oem_webstage\java-plugin with the following settings:

Alias: java-plugin

Path: c\oem_webstage\java-plugin

Access: Read-only

Note: Make sure you do not enable execute permissions; otherwise, you will not 
be able to download the plug-in.

14. Verify that the plug-in is installed on the system where you are running your 
web browser. It is located in the directory c:\oem_webstage\java-plugin. 
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preparing for repository migration, 7-8
starting, 7-12

migration phases, 7-3
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OEM_REPOSITORY tablespace, 2-12, C-21
oem_temp password, 1-6
oemapp console command, 6-2
oemclient.properties, A-2
oemctrl start oms command, 3-3
oemctrl status oms command, 3-5
oemctrl stop oms command, 3-6
OEM.MANAGEMENT_SERVER, 6-26
OEM.MANAGEMENT_SERVER.BOOTPORT, 6-2

8
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Oracle Application Server 4.0.8, E-1, E-3
Oracle Enterprise Manager
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architecture, 1-2
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Console, 1-3, 1-7, 6-1, 6-2, 6-12
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directory structure, A-1
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Intelligent Agent, 1-3, 1-7
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management server, 1-7, 3-1, 3-2, 3-5, 3-6, 4-1
repository, 1-3, 1-6, 2-1
repository owner, 1-6
system and hardware requirements, 1-4
temp directory, A-2
tracing and logging, C-5

Oracle Support, reporting problems to, C-2
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PHONE_NUMBER, 6-24
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TIMEOUT, 6-25
TRACEFILENAME, 6-30
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TRACING.LEVEL, 6-29
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paging.cfg.template, 6-21
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PHONE_NUMBER, 6-24
preferred credentials

definition, 1-8
preferred credentials for managed services, setting 

up, 6-16
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sizing, D-1
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providing Oracle Technical Support with 

information, C-4
reporting problems to Oracle Support, C-2
repository database default tablespace does not 

contain enough free space, C-21
resetting password, C-17
tracing and logging for the management 

server, C-5
tracing for client applications integrated with 

Enterprise Manager, C-8
using MetaLink, C-2
web browser, C-16

W
web browsers, supported, 6-7
                                                                      Index-5



webservers, supported, 6-8
Windows NT user account

assigning privileges to, 6-14
creating, 6-12
Index-6                                                                     


	PDF Directory
	Send Us Your Comments
	Preface
	Purpose of this Guide
	Audience
	How this Guide is Organized
	Documentation Set
	Related Publications
	Conventions Used in this Guide

	1 Introducing Oracle Enterprise Manager
	Oracle Enterprise Manager’s Architecture
	Oracle Enterprise Manager System and Hardware Requirements
	Basic Terminology
	What is a repository?
	What is a repository owner?
	What is an administrative user?
	What is a Console?
	What is an Oracle Management Server?
	What is the Oracle Intelligent Agent?
	What is service discovery?
	What are preferred credentials?

	Configuring Oracle Enterprise Manager Overview

	2 Creating a Release 2.1 Repository
	Creating a New Release 2.1 Repository
	Starting the Enterprise Manager Configuration Assistant
	Step 1 "Configuration Operation"
	Step 2 "Select Database for Repository"
	Step 3 "Repository Login Information"
	Step 4 "Select Repository User Tablespaces"
	Step 5 "Create Repository Summary"
	Step 6 "Configuration Assistant Progress Window"


	3 Controlling the Management Server
	Starting the Management Server
	Checking the Status of the Management Server
	Stopping the Management Server
	Checking the Management Server Log Files

	4 Adding Additional Management Servers
	Installing an Additional Management Server
	Setting Up an Additional Management Server
	Step 1 "Configuration Operation"
	Step 2 "Configuration Parameters"
	Step 3 "Modify Configuration Parameters"


	5 Starting the Intelligent Agent
	Starting and Stopping the Oracle Intelligent Agent on Windows NT
	Starting the Intelligent Agent on Windows NT
	Stopping the Intelligent Agent on Windows NT
	Verify Intelligent Agent is Running on Windows NT
	Starting, Stopping, and Verifying the Status from the Command Prompt

	Starting and Stopping the Oracle Intelligent Agent on UNIX

	6 Setting Up the Console
	Starting the Enterprise Manager Console
	Discovering Services
	Creating Administrator Accounts
	Running Oracle Enterprise Manager from a Web Browser
	General Setup
	Setting Up the Job System
	Creating a Windows NT User Account for Running Jobs
	Setting Up Preferred Credentials for Managed Services

	Setting Up Email Notification
	Setting Up the SMTP Gateway
	Setting Up Email and Paging Notifications

	Configuring and Starting the Paging Service
	Setting Up Paging
	Starting the Paging Service
	Querying Status of the Paging Service
	Stopping the Paging Service
	Paging Status Codes for Numeric Pages

	Configuring the Console If Using a Dialup Line to Connect to the Management Server
	Configuring a Remote Database for Backup or SYSDBA Administration
	Server Side (NT)
	Server Side (UNIX)



	7 Migrating a Release 1.x Repository to a Release 2.1 Repository
	Important Notes
	Phases of Migration

	How the Differences Between Release 1.x and Release 2.1 Impact Migration
	Preparing for Repository Migration
	Create New Release 2.1 Administrators
	Refresh All Services in the Release 1.x Console
	Shut Down the Release 1.x Console and the Release 2.1 Management Server
	Check the Information Currently in the Release 1.x Repository
	Back Up the Existing Release 1.x Repository

	Migrating the Repository Using the Migration Assistant
	Step 1 "Introduction"
	Step 2 "Component Selection"
	Step 3 "Source Repository Login"
	Step 4 "Target Repository Login"
	Step 5 "Administrator Data"
	Work in Progress

	Deleting and Deregistering All Active Jobs and Events from the Release 1.x Console
	Confirming a Successful Migration
	Backing out of a Migration
	Release 1.x Objects Reference
	Release 1.x Objects Which Will Migrate to Release 2.1
	Release 1.x Objects Which Need to be Re-created
	Release 1.x Objects Which No Longer Exist


	8 Setting Up DBA Studio
	DBA Studio in Standalone or Management Server Mode
	Direct Connection to Databases
	Connection through the Oracle Management Server

	Setting Up DBA Studio in Standalone Mode
	Starting DBA Studio in Standalone Mode
	Adding Databases to the Tree in DBA Studio Standalone Mode
	Connecting to a Database in DBA Studio Standalone Mode
	Editing Local Preferred Credentials in DBA Studio Standalone Mode

	Setting Up DBA Studio in OMS Mode
	Setting Up DBA Studio to Connect to a Management Server
	Starting DBA Studio OMS Mode
	Connecting to a Database in DBA Studio OMS Mode

	Other DBA Studio Procedures
	Accessing the Quick Tour in DBA Studio
	Connecting to the Database As a Different User
	Viewing Which Role You Are Connected As In DBA Studio
	Removing a Database from Tree in DBA Studio Standalone Mode
	Removing a Database from the Navigator in OMS Mode
	Adding Databases to the Navigator Tree For DBA Studio OMS Mode
	Changing from OMS Mode to Standalone Mode
	Changing from Standalone Mode to OMS Mode


	A Directory Structure
	Directory Structure of Oracle Enterprise Manager Release 2.1
	Directory Structure for $ORACLE_HOME\sysman
	Other Important Directories


	B Configuration Assistant Operations
	Upgrade a Release 2.0 Repository to a Release 2.1 Repository
	Step 1 "Configuration Operation"
	Step 2 "Select Database for Repository"
	Step 3 "Select Repository"
	Step 4 "Repository Login Information"
	Step 5 "Upgrade Repository Summary"
	Step 6 "Configuration Assistant Progress"

	Drop an Existing Repository
	Step 1 "Configuration Operation"
	Step 2 "Select Database for Repository"
	Step 3 "Select Repository"
	Step 4 "Select Drop Repository Options"
	Step 5 "Drop Repository Summary"
	Step 6 "Configuration Assistant Progress"

	Edit Configuration Parameters
	Step 1 "Configuration Operation"
	Step 2 "Configuration Parameters"
	Step 3 "Modify Configuration Parameters"

	Configuration File Not Accessible

	C Troubleshooting
	Reporting Problems to Oracle Support
	Manuals
	MetaLink
	Oracle Technical Support

	Setting Up Logging and Tracing
	Tracing and Logging for the Management Server
	Logging and Tracing Properties
	Management Server Logs

	Tracing for the Client
	Tracing for the Web Browser
	Tracing for Paging

	Troubleshooting the Management Server
	Management Server May Not Run Correctly from a Non-Default Oracle Home
	Management Server Does Not Start from the Windows NT Start Menu
	You Did Not Enter the Repository Credentials in the Service Dialog
	You Enter the Wrong Credentials in the Service Dialog
	Accessing the Windows NT Event Log

	Changing Your Management Server for Client Access
	Setting the Ping Interval

	Troubleshooting the Paging Service
	Paging Does Not Work
	Registering the Paging Service with a Remote Oracle Management Server
	Modifying the Paging Service Information from the Enterprise Manager Console
	Page Notification Fails

	Troubleshooting the Web Browser
	Resetting the Password
	Troubleshooting the Enterprise Manager Configuration Assistant
	Enterprise Manager Configuration Assistant Errors
	Repository Database Default Tablespace Does Not Contain Enough Free Space
	Creating an OEM_REPOSITORY Tablespace if One Does Not Exist
	Creating Another Tablespace
	Increasing the Size of an Existing Tablespace

	Database Parameters Not Large Enough for Repository Operation

	Changing the Permissions on the omsconfig.properties File
	Determining the SGA Size
	Troubleshooting Job Notifications

	D Repository Sizing
	E Configuring the Webserver and Directory Mapping
	Apache 1.3.9 on Solaris
	Oracle Application Server 4.0.8 on Windows NT and Solaris
	Internet Information Server (IIS) 4.0

	Index

